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Digital Literacy 

Module 01: Training Environment and Computer Basics 

Introduction 

 

This course is computer-based training course offered to all who are interested in using technology 

to complement their career choices and be more productive at work and home. Upon completion 

of this course, you will have a fundamental understanding of the computer and its usage. You will 

learn the essential skills required to begin computing with comfort and confidence. 

 

Your learning in this course will be guided through the below six modules; 

 

Module 1 – Introduction to Computers 

Module 2 – Using the computer and managing files 

Module 3 – Word processing 

Module 4 – Spreadsheets 

Module 5 – Presentation 

Module 6 – Internet and communication 

 

What is a computer? 

Computer is an electronic device that takes data, instructions and information as input and produce 

output (information) after processing it. 

 

It is a machine that processes thousands of instructions in less than a second and produces outputs 

as instructed or programmed. 

 

Advantages of computers 

 

1- Efficiency 

Machines are more efficient than humans. They can perform millions of calculations with less 

effort in no time. 
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2- Reliability 

Work done by computer is more reliable than one done by humans. Computers perform according 

to the instructions given to it that makes output or results produced by these more accurate and 

reliable. For example, a computer can do millions of error free calculation in less than a second. 

 

3- Storage 

Computers give you an advantage of storing large amount of data in one place. For example, you 

can store the data of whole library in one computer. 

 

4- Fast results 

Computers are capable of doing many difficult tasks in very short time. Every day the processing 

speed of computers is increasing to make them work faster. Latest computers are capable of 

performing thousands of instructions and calculation in less than a minute which used to take hours 

with old PCs. 

 

Basic terms for computer 

Input 

Whatever goes into the computer is called input. For example, text, graphics, sounds, etc. In 

everyday life, the example for input is a voting slip in a ballot. 

 

Input Devices 

An input device is any peripheral (piece of computer hardware equipment) used to provide data 

and instruction to a computer for example, keyboard and microphone. Everyday life example is 

a hand that is used to put the voting slip in a ballot box. Thus hand is an input device for ballot 

box. 
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Output 

Anything that comes out of a computer is called output. For example sound of a playing video 

in computer is the output. 

 

Output Devices 

An output device is a hardware used to get the output from the computer. For example, headphones 

are output device and used for listening sound in computer. 

 

Processing  
Computer is given the data and instruction as input, which is processed to create output in the form 

of information. Data is a raw form of symbols, numbers, images, etc., whereas information is an 

organized, meaningful and useful form of the data. For example, some data (student roll number, 

name, total marks, obtained marks etc.) from the mid exam is entered. Computer process the data 

and creates a report of passing and failing students. This report is more organized and useful for 

us, and thus information rather than just data. 

 

Storage 

Storage, also referred as memory, is the ability of a computer to store data, information or 

instructions. It can save digital data on RAM, hard disks or removable memory. 

 

Storage Devices 

Storage devices are used to store data when they are not being used in memory. The most common 

types are USB drive, hard disks and CD-ROM and DVD. 

 

Hardware 

Hardware refers to the physical elements of a computer. Examples of hardware in a computer are 

the keyboard, the monitor, the mouse and the processing unit. 

 

In contrast to software, hardware is a physical entity, while software is a non-physical entity. 

Hardware and software are interconnected, without software; the hardware of a computer would 

have no function. 
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Software 

How does a computer use its hardware? 

The term software refers to programs or sets of instructions that the computer uses to perform 

computer operations. Software can also be described as a collection of routines, rules and symbolic 

languages that direct the functioning of the hardware. Software is capable of performing specific 

tasks, as opposed to hardware which only perform mechanical tasks what they are mechanically 

designed for. 

 

We can think or write instructions but cannot touch them. 

 

Characteristics of software 

 Software is intangible (you cannot hold it like hardware). 

 It is weightless.  

 It does not exist as a hardware. 

 Software is used to operate the computer. 

 

Types of Computers 

There are five basic types of computers. 

 

Super Computers 

Super Computers are the fastest computers, and because of their speed and memory, are capable 

of performing operations that would not be practical for PCs or mainframes. 

 

Advantages of Super Computers 

High Speed 

Most Accurate 

Most Expensive 

 

Examples 
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Titan-Computers, k-Computers and Tianhe-2 

 

Mainframe Computers 

Mainframes are computers where all the processing is done centrally, and the user terminals are 

called "dumb terminals" since they only input and output (and do not process). 

 

Mainframes are computers used mainly by large organizations for critical applications, typically 

bulk data processing such as a census.  

 

Examples 

PTC, PIA, Banks and other organizations in Pakistan use mainframe computers 

Servers  

A server is a central electronic machine that exchange data with all linked machines. 

 

Examples  

 Dell, HP and Acer  

 

Microcomputers  

PC is an abbreviation for a Personal Computer, it is also known as a Microcomputer. Its physical 

characteristics and low cost are appealing and useful for its users. Throughout the 1970s and 1980s, 

home computers were developed for household use, offering some personal productivity, 

programming and games, while somewhat larger and more expensive systems (although still low-

cost compared with minicomputers and mainframes) were aimed for office and small business use. 

 

Examples 

 HP, Dell, IBM and Apple Macintosh  

 

Game Console 

 

Game Console is a device that allows one or more person to play game. These are portable devices.  

 



 

 

 

10 

 

Digital Literacy                                                                           
 

Examples 

 Microsoft XBOX 360, Nintendo WII and Sony PlayStation 

 

Mobile Computers 

A portable computer is a small personal computer designed for mobile use. A portable computer 

integrates all of the typical components of a desktop computer, including a display, a keyboard, a 

pointing device (a touchpad, also known as a trackpad, or a pointing stick) and a battery into a 

single portable unit. 

 

Example  

 Laptop computers 

 

Mobile Devices 

Mobile device is a computing device that can set in hand easily. It has less computing power than 

personal computers.  

 

Example 

 Book Reader, Digital Camera and Smartphones 

 

Embedded Computers 

An embedded computer is a small and less computing power device that can be fixed as a 

component in any product.  

 

Example 

 DVD Player, Digital TV and Photo Copy Machine 

Summary 

In this lecture we learnt: 

 What is a computer? How is it used in our daily life? 

 Advantages of computer 

 Basic computer terms, e.g., storage, output, input, etc. 

 Types of computer 
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Digital Literacy 

Module 01 

Hardware 

 

Objectives 

The objectives of these topics are to provide information about: 

 Computer hardware 

 Computer components and parts 

 Computer components and functions 

 

Computer Hardware 

Hardware refers to the physical elements of a computer. Examples of hardware in a computer are 

the keyboard, the monitor, the mouse and the processing unit 

 

System Unit 

It refers to the box that encapsulates the processor, motherboard, cd drives, hard drives, 

memory, ports etc. 

 

Terms related to the system unit 

Following are the terms for external parts of computer casing. 

 

Computer casing is the box that houses the computer. 

Power button is used to switch on the computer. 

Lights show the running status of the computer 

CD ROM is the input device used to read data from CDs. 

USB Disk is a small, portable flash memory that plugs into a computer's USB port 
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Ports and Pin Sockets 

It is an interface that links computer with the monitor and other peripherals. 

 

Power Connector is a socket used to supply power to the computer 

Power Cable is used to supply power to (the) monitor. 

USB Port is a point of connection between a computer and other electronic devices such 

as (a) webcam, scanner, printer, mouse and keyboard. 

Keyboard Port is a socket used to connect keyboard to the computer. 

Mouse Port is a socket used to connect a mouse to the computer. 

Serial Port is a socket on a computer that is used to connect scanner, mouse etc. It got 

9pins. 

Parallel Port is a socket at the back of the computer to connect printer. It got 25 holes. 

Pin Sockets are used to connect speakers, microphone. 

Drive Bay is a place where hard drives are installed using screws 

Power Supply provides power to processors, mother board etc. 

Mother Board holds together the central processing unit (CPU), memory and connectors 

for input and output devices. 

Processor is a brain of computer and does all the processing. 

Fan is used to cool down the processor to avoid it from being damaged 

RAM Chip is random access memory used by computer system to keep the running 

program here. 

 

Interface cards 

Sound card is the interface used to produce sound via speakers 

LAN card is used to develop a network (more than one computer connected to each other)  

 

How does computer work? 

Following diagram explain how a computer works in a very generic form. Data goes into memory 

as input and from there it goes for processing. After processing, it goes back to memory, from 

memory it is sent as output or it is stored. 
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Summary 

In this lesson we learnt information about: 

 

 Various hardware components of computer 

 

 System unit lights, buttons on it, front panel 

 

 Ports such as serial ports, parallel ports, USB ports, Pin sockets 

 

 Drive Bay, Power supply, Motherboard, Card slots, RAM slots, Processor, Fan 

 

 

 

 

 

 

 

 

 

Input 

Memory 

Process 
Output 

Storage 
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Digital Literacy 

Module 01 

Input Devices 

 

 

Objectives 

The objective of this lecture is to provide answers to the following questions: 

 What is a keyboard? 

 Function of keyboard keys 

 

Keyboard 

It is an input device to give computer some input. It is like pen in writing. It is called keyboard 

because it is comprised of a board with keys installed. Every key sends unique information to the 

computer. 

 

Process of key pressing 

A keystroke is a single press of a key on a keyboard. 

 

Keyboard types 

There are different types of keyboards. Standard keyboard is the most commonly used keyboard. 

Key arrangement can be different for these keyboards. Some may have special keys for other tasks 

than just typing. These special keyboards are usually used for multimedia purposes like video 

editing, sound design etc. 

 

Basic Keyboard keys 

There are usually 104 keys on standard keyboard. Pressing the key once and releasing it is called 

a keystroke. 
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Character keys 

These are used to enter alphabetic characters. These characters become uppercase when pressed 

with shift key or caps lock is on. 

 

Numeric keys 

There are 10 numbers or numeric keys (1, 2, 3 to 9 and 0) on standard keyboards. These are used 

in the same fashion as typewriters’ keyboard to enter numbers. These become symbols or 

punctuation marks when pressed with the shift key. 

 

For example 

 

1- Shift + 8 will print * 

 

2- Shift + 4 will print $ 

 

Special keys 

Shift, ALT and Control (Ctrl) keys are special keys and when pressed with other keys, perform 

special operations. For example, Ctrl+C will copy the selected file or text, shift+ character key will 

print that character in capital. 

 

Escape keys 

It is used to escape/exit from certain type of applications. 

 

Function keys 

F1, F2, …. F12 are called function keys. These are used for different purposes. For example, F5 is 

used to refresh the web page in internet browser. F1 will open help window. 

 

Arrow keys 

There are four keys (arrow keys) for cursor navigation. 

 

Left arrow key, Right arrow key 
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Up arrow key, Down arrow key 

 

Numeric keypad 

On the right side, a separate area is reserved for numeric keys, mathematical operational keys (+ 

, - , * , /) , enter, dot and Num Lock key. 

 

Space Bar 

It is horizontal wide key, in the lowermost row. It generates space between two characters. 

 

Punctuation keys 

These are keys to enter punctuation and are located on the right side of alphabet keys. 

 

Enter key 

Enter or return key cause cursor to go to next line, form or window to perform its default function. 

 

Application key 

It launches the menu with the keyboard rather than the usual right mouse button. 

 

Toggle keys 

Caps lock, Num lock and Scroll lock keys are toggle keys. At the top right corner, there are three 

small lights to show the status of these locks. When pressed one, corresponding light is turned on. 

 

The keys on the numeric keypad act as numbers and dot. When this key is pressed again and the 

corresponding num lock key light is switched off, the key act as arrow keys, home key, pg up, pg 

down and end keys. 

 

Characters become capital when the caps lock is on. 

Scroll key modifies the functionality of arrow keys. When the scroll lock is on, the arrows 

keys would scroll the window instead of moving the cursor. 
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Print screen key 

It is the key which is used to save (capture) all the contents of the screen in a temporary area. 

 

Insert key 

Key use to insert or overwrite character(s) within a word is called Insert key. The key acts as 

toggle key. If it is in the insert state than any character pressed while the cursor is placed within a 

word gets inserted. If the key is pressed and it is in the overwrite state than any character pressed 

while the cursor is placed will get overwritten. 

 

Home key / End key 

It is used to go to start (home key) or end (end key) of the document. 

 

Page up key / Page down key 

It is used to go to previous (page up key) or next (page down key) page. 

 

Delete key 

The key used to delete characters. 

 

Backspace key 

The key used to delete the preceding characters. 

 

Non-Typing Keys 

Alt, Ctrl and shift keys are non-typing keys. They don’t print anything when pressed. These when 

pressed with other keys, modify the usual operation of that key. For example, Alt + F4 close the 

active window. 

 

Tab key 

Tab key is a typing key and used to put more than one space within characters or words. 
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Other Input Devices 

 

Microphone 

Microphone is used to input the sound to computer. It is used in motion pictures, radio and 

television broadcasting etc. 

 

Scanner 

Scanner is a device that scans images, papers etc. to store them in computer for later use. 

 

Digital camera/Web cam 

These are input devices that input still images or video to computer. 

 

Summary 

In this lecture we have learnt: 

 

 What is keyboard? What is its use? 

 

 Keyboard types 

 

 Standard keyboard keys 
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Digital Literacy 

Module 01 

Software 

 

Objectives 

The objectives of these topics are to provide information about: 

 

 What is software? 

 

 Types of software 

 

 Tasks performed by software. 

 

 The software versions 

 

 

Computer Software 

A Software is a set of instruction given to a computer to do specific tasks. A computer requires the 

collective support of hardware and the software to produce a useful output.   

 

Software versions 

A Software is developed and updated periodically. When a software is updated and a new copy of 

this updated is available in the market it is called a new version of a software. 

For example  

 

Operating System Year 

Windows 95 1995 

  2001 

Windows Vista 2006 

Windows 7 2009 

Windows 8 2012 
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Types of Computer Software 

 

There are three basic types of computer software. 

 

 

 

 

System Software 

It maintains and control computer hardware. There are two kinds of system software. 

1. Operating system 

 

2. Device drivers 

 

Operating System 

Operating systems manage and coordinate the activities of the computer hardware and other 

software. 

 

Device Drivers 

It manages the hardware like a driver manages the car. The Operating system gives instructions to 

the particular drivers which are responsible for the required action. For example, The Operating 

system knows which driver to access when a print command is given and subsequently the printer 

driver is responsible to carry out that task. 
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Utility Software 

It manages hardware, operating system or application software and perform specific task. It 

performs tasks like maintenance, troubleshooting, virus scanning etc. Disk scanner and antivirus 

are example of utility software. 

 

Application software 

The Software belonging in this category help in daily life tasks like calculation, 

presentation, text editing etc. This is most commonly used type of software. 

 

Word processor 

It is complex form of text editors that use to provide the basic functionality of saving, editing, 

updating, and formatting text. MS word is most common and widely used word processor. 

 

Spread sheet 

It helps in accounting and finance work. It contains cells (Rows and Columns) that contain a value. 

Different formulas can be applied on these values using by default functions. 

 

MS Excel is most commonly used software for developing spread sheets. 

 

Presentation software 

MS PowerPoint is presentation software that is used by business people, educators, students and 

trainers to present some idea or information in form of text, image or sound. It consists of pages 

or slides that may be arranged in a consistent style to give a feel of presentation. 

 

Microsoft 

It is the one of the biggest software companies in the world. It has developed famous windows 

and application software like MS word, MS excel, MS power point etc. 
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Summary 

In this lecture we learnt: 

 What software is? 

 Types of software 

 Users and functionality of software 

 What is meant by a version of a software? 
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Digital Literacy 

Module 01 

Pointing Devices 

 

Objectives 

The objective of these topics are to provide information about 

 

 What is a computer mouse? 

 

 Function of computer mouse 

 

 Some other pointing devices  

 

Pointing devices 

Devices used to point things at the computer screen are called pointing devices. For example, 

mouse, track pad, etc. 

 

Mouse 

Mouse is a pointing device that works by detecting motion relative to its 

supporting surface. Furthermore: 

 

There are many types of computer mouse available in the market. 

They usually have different shapes or buttons, but they work almost 

in the same fashion. 

 

Mouse Buttons 

There are two buttons on standard mouse 

 

1- Right mouse button 2- Left mouse button 
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Single Click 

Press mouse button one time  

 

Double Click 

Press mouse button two time instantly. 

 

Dragging  

Drag an object such as an icon, first move mouse cursor over it. Then press and hold left mouse 

button and move object to the desired location.  

 

Mouse Pad is a surface used to sense the mouse motion. 

Mouse Pointer/Arrow/Cursor shows the position and motion of mouse on screen. 

 

Trackpad 

Trackpad (also known as touchpad) is a pointing device consisting of a sensitive surface that 

translates the motion of a user’s finger to a relative position on screen. 

 

 

Trackball 

Trackball is a pointing device with a ball placed in a socket with sensors to detect the rotation of 

the ball.  
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Digital Literacy 

Module 01 

Storage 

 

Objectives 

The objectives of these topics are to provide information about 

 

 Computer storage 

 

 Types of storage 

 

 Commonly used storage devices 

 

Storage 

Process of storing information in computer is called storage. The devices used to store data are 

called storage devices. 

 

Advantages of storages 

Information at different places can be saved in computer and can be accessed when needed. 

 

Types of storage devices 

 

1 -Primary storage devices 

2- Secondary storage devices 

 

 

 

 

 

 

 

 

Storage Devices 

Primary Storage Devices 

Primary Storage Devices 
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Primary storage devices 

Storage devices which are installed on the motherboard are called primary storage devise. It is 

also called memory. 

 

Types of primary storage 

There are two types of primary storage devices  

1- ROM 2- RAM 

 

ROM 

ROM stands for read only memory. It is a storage device from which only stored information can 

be read. It can’t be modified, delete or removed. It is like something written on stone that cannot 

be removed or changed once written. It is permanent storage devise and data remains safe on ROM 

even when computer is off. 

It contains information related to computer startup process which is written at the time of memory 

manufacturing. Computer cannot start without ROM. 

 

RAM 

RAM stands for random access memory. It is like something written on sand which is temporary 

and would be erased. It is temporary memory, also called volatile memory. RAM stores 

information which is currently processed by computer. When power off, it loses all the 

information. Data can be read, stored, modified or delete from the RAM. 

 

Size of storage 

Byte is the unit for measuring memory. 1 byte means 1 character 

 

For example, Pakistan is consisting of 8 bytes. 

 

Byte is small unit 
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1024 bytes = 1 kilo byte (kb) 

1024 kilobytes = 1 megabyte (mb) 

1024 megabyte = 1 gigabyte (gb) 

 

Secondary storage devices 

Why are secondary storage devices needed? 

 

RAM stores info temporary, whereas we can’t store information on ROM. So, we need some place 

to store information, even when computer is off. It is also called non-volatile storage devices. For 

example, USB disks, hard disks, compact disks, magnetic disks etc. 

 

Advantages of secondary storage devices 

 

1- More data can be stored as compared to primary storage 

devices  

2- Information remains there even if power is switched off. 

 

Types of secondary storage 

1- Magnetic disks 2- Optical disks 

 

Magnetic disks 

Hard disk is considered in this category. 

 

Hard disk 

It is made of hard material, sealed in casing. More than one hard disk can be sealed in a casing to 

increase the storage capacity in computer. Data is stored in circular form. Storage capacity of hard 

disk is very high and high volume of data can be stored here. Don’t bring near magnets and should 

not place in high temperature area. 
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Optical disks 

It is called optical disk because laser beam is used to read and write the data. Diameter is 4.75 

inch, whereas width is less than 1/20th of an inch. It is easily portable device. 

There are four types of optical disks 

 

CD ROM 

CD stands for compact disk and ROM stands for read only memory. It is read only storage 

device, mostly used for audio, videos, etc. 600 MB to 800 MB data can be stored. It is easy 

portable devices. CDs should not be scratched. 

 

Write once read many (WORM) 

It acts as CDROM after data are written on it once. It is used to store data, information. 

 

Re-writeable CDs 

CDs which can be read and write many times are called re-writeable CDs. 

 

DVDs 

DVD stands for digital versatile disk. It was invented to store video only that is why previously 

it was called as a digital video disk. Its capacity is much greater. 

 

DVD ROM – Data can be read from it, but cannot be written, changed or deleted. 

 

DVD RAM – It works like re-writeable CDs. Data can be read, written, stored or removed 

from it. Storage capacity is huge from 4.7 GB to 9.4 GB. It is easily portable. 

 

Other storage devices 

 

Magnetic tape 

It is like an audio cassette. Data is saved in line. Data saved first would be read first. It has huge 

storage capacity. Keep it away from magnet to save from damage. 
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Summary 

In this lecture we learnt about: 

 

 Different storage devices (RAM, ROM) 

 

 Magnetic devices (HD, FD) 

 

 Optical devices (CDs. DVDs) 
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Digital Literacy 

Module 01 

Security 

 

Objectives 

The objectives of these topics are to provide information about 

 

 What is meant by security of computer? 

 

 Risk associate with computer. 

 

 Methods of protection against these risks 

 

Security Risks 

There are risks associated with hardware, software, data etc. that can cause a big loss to the 

owner. One should do preventative actions to avoid these security risks. 

 

Types of risks 

 

Hardware theft 

Save hardware/computer from stealing by placing it somewhere safe. 

Virus 

Computer virus is software that damage computer. For example, it may cause your computer to 

restart when you open MS word. 

Antivirus 

Antivirus software is used to eliminate virus from computer. It scans hard disk to find virus and 

terminate them. It also stops entering new virus into computer. A new version of antivirus helps 

to prevent viruses to damage computer or data. 
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Unauthorized access 

If you don’t want someone else to access your data in computer, you can protect your 

computer/data with password. It will reduce the risk of unauthorized access to your pc. Password 

is a unique word that identifies the user. 

 

Backup 

Data saved in your computer may lose due to some reason. In case of having its backup (same data 

at some other place/storage device) you can access and use it. Backup is the process of copying 

data. For example, you have prepared a presentation and due to virus attack it got damaged or 

deleted. If you have its backup file at some secondary storage media like floppy, etc., you can 

restore the presentation from that device. 

Backup utilities help to organize backup data (that data being copied). 

 

Software piracy 

If someone copy and sells the software of any developer or company without its permission, then 

he is doing piracy. It is the biggest problem software industry is facing now. Copying and selling 

software in such manner is against software copyright act. 

According to the copyright act if someone steals the software Or 

Copies or sells it without the permission of the owner/developer 

Legal action is taken against him. 

Summary 

In this lesson we learnt: 

 

 What is hardware security? 

 

 Different types of security risks 

 

 What is meant by computer virus? 

 

 What is meant by anti-virus? 

 

 What does data backup means? 

 

 What is software piracy? 
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Digital Literacy 

Module 01 

Output 

 

Objectives 

The objectives of these topics are to provide information about 

 

 What is output? 

 

 What are the types of output? 

 

 What are the commonly used devices? 

 

Computer Output 

It means taking something out from computer. 

 

Types of Output 

In general computer output is of 2 types 

 

1. Soft copy 

2. Hard copy 

 

Forms of Output 

Text, Image, Sound, Multimedia (2 or more forms are combined for example text, image, sound) 

 

Output devices 

Printer – Print text or image being safe in computer on paper 

 

Monitor – Output display 

Speakers – Output sounds being played in computer 

Multimedia projectors – Output multimedia 
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Printer and its types 

 

Printer 

It is an output device that prints image or text being safe in computer. The output is hard copy. 

 

Types of printer 

 

1- Dot matrix 

Dot is a spot of ink, whereas the matrix is a particular arrangement of dots. 

 

It works like a typewriter and consist of pins. A pin makes a dot and combination 

of dots forms characters and illustrations. Printing speed of a dot matrix printer is 

around 300 char/sec. 

 

Examples are Epson LQ 58 E, Microline 420 

 

2- Line printer 

It works like Dot matrix printer, just it prints a complete line at a time. It contains 

a chain of pins that helps to print an entire line. It is superior in speed and quality. 

Usually a line printer prints 200 lines/min. 

 

Examples are Tolly T6218, Printrox P5220 

 

3- Laser printer 

 

It produces high quality graphics by using the same technology as in photocopy 

machine. It prints a complete page at a time and works like a photocopier. It can 

print upto 6 pg/min. For printing laser printers use powder ink that is available in 

cartridge. These printers are quite expensive. 

Examples are HP laser jet 4300, Samsun ML 1710 

 



 

 

 

34 

 

Digital Literacy                                                                           
 

4- Inkjet printer 

It has nosals which make dots to print. Inkjet printers are low in cost. 

 

For example, Lex mark Z35 Color Inkjet printer, Epson stlys C82 Color inkjet 

printer 

 

Monitors and its types 

Whatever is on screen is called display. Monitor is like TV and it output the softcopy of software 

and programs in computer. Like regular TV, it has some buttons as well that includes Power button 

and display adjustment buttons. 

 

Types of monitors 

 

1- CRT monitors 

These are cathode ray tube monitors and commonly used for personal use. 

Examples are Philips Professional Brilliance 107P, Samsun Syncmaster 551v 

 

2- LCD monitors 

Liquid crystal is used for the screen which is also used in scientific calculator. It got 

advantage over CRT monitors due to look, lightweight and compact size. These can be 

adjusted in less space. 

Examples are Samsung Synmaster LCD, Sony LCD monitor 

 

Speakers 

Different types of computer speakers are available in the market. These speakers work very 

much like regular speakers. 

Examples Yamaha 5.1 

 

Logitec z-640 
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Multimedia projectors 

Display and sound to have it on some screen. It works like a magnifying glass. Examples 

 

Epson Powerlite 8118 Toshiba 

Digital Multimedia 

 

Summary 

In this lesson we have learnt: 

 

 What are computer output and output devices? 

 

 Types of output 

 

 Commonly used device e.g. Printer, Monitor, Speaker 
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Digital Literacy 

Module 01 

Internet 

 

Objectives 

The objectives of these topics are to provide information about 

 

 What is meant be Internet? 

 Services available over the internet 

 World wide web 

 Email 

 How to access the internet? 

 

Internet 

Internet is network of networks. It doesn’t belong to any one and no one runs it. People around 

the globe access internet via telephone line or satellite. 

 

How to access it? 

Internet Service Provider (ISP) is a company or organization that connects the users with internet. 

ISP is always connected to internet and people who want to access internet, connect it via their 

local ISPs. 

 

It is used to share information and resources over internet. 

 

Services over Internet 

1- World Wide Web 

2- Email 
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World Wide Web 

Web meant net. It was originally designed to share information among scientific community. 

But now it is the most popular way of sharing information. 

 

Web page is a resource of information written in html. 

 

Web browser is software that is used to view webpage. 

 

Popular Web Browser  

Internet Explore 

Mozilla Firefox 

Google Chrome 

 

Website 

Web site is a collection of related web pages. Every website has a unique address to access 

it. It is called uniform recourse locator (URL). For example, www.vu.edu.pk is the URL for 

the virtual university’s website. 

 

Links provide us the access to other web pages in website. You may have seen links like home, 

contact us, about us etc. 

 

Advantage of web is availability of huge resource of information. For example, temperature 

of different parts of world is available over the web. 

 

How to reach the web? 

1- Connect telephone line to computer 

2- Connect to ISP 

a. Enter ISP phone 

b. Enter user name and password to connect 
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3- Open browser 

 

4- Enter URL and browse internet 

 

 

 

 

 

Email 

It is like regular mail just with a small difference that you need computer to read, write or 

send email. It is used for communication between people who are at distance. Its delivery is 

faster, safer than regular mail. Probability of losing is very low, and it can be viewed from 

anywhere in the world as it resides on internet. 
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Email address is used to send email from one computer to another e.g. info@vu.edu.pk is an email 

address to send email to Virtual University of Pakistan. 

 

Email client 

Email client is software to compose, sent, receive or read email. You can access your emails 

from anywhere in the world. All you need is email id and password provided. This ensures 

authenticated access to your emails. Password is a secret word, used to uniquely identify the 

user. Some famous email clients are MS outlook, Neo mail, Lotus notes. 

 

Popular Email Clients  

Gmail 

Hotmail 

AOL 

Yahoo Mail 

Microsoft Outlook 

Summary 

In this lesson we learnt about: 

 

 Internet, web, email 

 

 Web site, Webpages 
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Digital Literacy 

Module 02: Using the Computer 

Introduction 

Objectives 

 
The objectives of these topics are to provide information about 

 How to ON/OFF the computer? 

 Desktop environment 

 Introduction to “Windows 7” 

 Operating System 

 Identifying installed RAM 

 CPU processing speed and its brand 

 Computer configuration  

 Use of help command 

 

Starting the computer 
Press the power button on system unit to start the computer. The area you will see on the monitor 

screen, after computer a start is called desktop. It is called desktop because you can use it like the 

top of the desk to place the icon or shortcut to your favorite programs or soft wares. 

ICON is a graphical representation of files, folders, disk drives, toolbar buttons etc. Name of the 

icon, file, folder etc is written just below it. The word icon came from the Greek word “eikon” 

which means image. Still religious pictures are called Eikon in Greek. In windows, these icons are 

links to software to open it with double click of the mouse. You can design such icons yourself as 

well. 

Taskbar is the bar at the bottom area of desktop (monitor screen). Icons of our tasks and software 

being used will appear here. It is called taskbar because it shows the tasks being carried out in 

computer. Microsoft window’s icon (Start button) resides at the left side of the task bar. At the 

right side of this button, quick launch bar exists. Icons reside here open their respective programs 

with single click. System tray exist at the right side of the task bar, which may contain some icons 

like antivirus programs, firewall software etc. Icons in system tray represent programs which work 

in background. For example, an antivirus program works consistently in the background to protect 
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your pc from viruses and only icon display here. In the same system tray, there is a clock indicating 

the system time. It is called system clock. 

 

 

 

How to shut down the computer? 
Click on start (located at the bottom left side of the task bar on monitor screen). A list of program 

names and commands will appear. Click on the option “Shut down”. Clicking on Shutdown button 

will shut down your PC. 

 

Pressing power butting of your computer during work may damage your pc and all data will be 

lost. 

How to restart computer? 
You may need to restart the computer. 

Why we restart computer? 

 

There can be several reasons for restarting computer. Like new installation of any software can 

ask for restart or computer suddenly stops working (halt). 
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To restart your computer, click on start button at the taskbar. Click arrow to next shutdown button 

to open the shutdown dropdown menu and select restart from the menu. It will shut down the 

computer and starts it again. 

 

Window and its structure 
Window is software developed by Microsoft which is usually called Microsoft windows. Window 

has different versions like window 98, window XP, window Vista, window 7 and window 8, 

window 10 etc. Although these versions are similar to each other but every new version is better 

than the previous and provides new features as well.  

Basic windows properties 
Click on “My Computer” icon. A new screen will open. It is called computer folder. 

A blue bar at the top of the window has 

 

1. Buttons to restore down Maximize/Minimize and Close the window. 

 

 

 

 

 

 

 

 

Clicking on minimize button to hide window on taskbar.  

Desktop can’t be seen when any window is maximized.  

Clicking on cross button at right side of window will close window.  

 

 

Minimize  Maximiz

e Close 
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Status bar 
It resides at the bottom of the window. It provides some information related to that window. 

 

System Information 

Right Click the “Computer” 

Window open which contain system information for example, name of operating system installed 

on computer and RAM capacity etc.  
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Change system time and date 
The notification area (system tray), which includes a clock and icons (small pictures) that 

communicate the status of certain programs and computer settings. 

Click Time in system tray 

Click Change date and time settings  

Complete details visit: http://cpl.vu.edu.pk 
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Change System Sound 

Click speaker icon in system tray to change volume 

To adjust desktop background and theme: 

Right click the desktop and choose Personalize 
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Select the desired theme. Or browse for more themes online. 

 

 

 

Click Desktop Background, Window Color, Sound, or Screen Saver to customize any these options 

for the selected theme. 

Help and Support 

Microsoft provides extensive help and support feature to do certain things on your computer. 

HELP AND SUPPORT functions by clicking on the START button and select HELP AND 

SUPPORT or Press F1 through keyboard.  

 

Summary 
In this lesson we learnt about the basic system properties  
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Digital Literacy 

Module 02 

Introduction to Desktop Environment 

 

 

Objectives 

 
The objective of these topics are to provide information about 

 Icons 

 Working with Desktop Icons 

 Basic Desktop Icons 

 Areas of Desktop 

 Changing the Size of Window 

Icon  
Icons are small pictures that represent programs, files, folders, or other things on the desktop. 

Objects with the same characteristics, like file folders, have the same icon. 

Moving an icon 
To move an icon, we have to select it first. 

 

Click on icon and without releasing the button to the position you want to place 

Release the mouse. 

Recycle Bin 
It resembles to the waste bin and got a recycle logo on it. It got all the deleted files or folders from 

the computer. If we want, we can restore deleted files from recycle bin but if once these files are 

deleted from the bin, we cannot have them back. 

To delete a file or folder 

Right Click on file or folder  

Choose delete  

Or 

Drag this file to the Recycle Bin 

Or 
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Select it first by clicking on it once. Now press “Delete” button on keyboard.  

Recover files from the Recycle Bin 
 

1. Open the recycle bin 

2. Do one of the followings: 

 

To restore a file, click it, and then, on the toolbar, click Restore this item. 

To restore all of the files, make sure that no files are selected, and then, on the toolbar, click Restore 

all items. 

 

Understanding files and folders 
In computer data is saved in form of files. We put these generated files in folders on hard disk. To 

access our desired file, we have to open associated drive and then folder(s). This is called the path 

to the file. For example, we have a file “song1.mp3” in folder “Songs” which is placed in drive C. 

To access song1.mp3, first we will open drive C, and then folder Songs. In this case 

C:\Songs\song1.mp3 would be complete path. 

 

Window Explorer 
With the help of this window, we can browse the folders and files in our computer. Click on Start 

> All Programs > Accessories > Windows Explorer 

It has two parts unlike any other window e.g. my computer’s window 

 

1- List panel on left side 

2- Detail section on right side 

 

Resizing and moving a window 
To resize a window, select window’s bottom right edge and drag inside or outside without releasing 

the mouse. We can resize a window by dragging any of its edge with mouse pointer. 

To move a window, click on the title bar of the window, and move it without releasing the mouse. 

With the help of scroll bars, we can see the content of window, which wasn’t visible before. There 

are two kinds of scroll bars in window. 
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1- Vertical scroll bar to scroll the window in up and down direction. 

2- Horizontal scroll bar to scroll it left and right direction. 

Application windows 

 

 

Active and Inactive Window 
No matter how many windows you have opened, you can work only at one of them at a time. Title 

bar color of the window that is in use is different from other windows. The window that is in use 

has a dark colored title bar and is called active window. The window that is not in use has a light-

colored title bar and is called inactive window.  

 

Closing Application Window 

Click button Or Click File and Choose Exit  

 

Summary 

In this lesson we have learnt: 

 Basic Desktop Icons 

 Areas of Desktop 

 Changing the Size of Window 
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Digital Literacy 

Module 02 

Organizing Files 

 

 

Objectives 
The objectives of these topics are to provide information about 

 Directories / Folders 

 Widely Used Type of Files 

 Copying, Saving and Backup of Files 

 Deleting Files and Formatting Disk 

 File Searching 

 

Creating a folder 
To create a new folder, right click on the empty area of the desktop and select New < Folder New 

folders are always named as “New Folder” by computer. Folders within folders can be created. 

These are called sub-folders as they reside inside some main folder. The purpose of creating folders 

within folders is to organize our data in a structured form. 

 

To view the properties of a folder 

 

1. Select the folder. Go to File menu and click on Properties. A new window call Properties 

Panel will open. 

 

2. Right click on a folder. Go to Properties. 

 

Window Properties Panel consists of many tabs, for example  

 

1. General Tab – It will have Folder name, type, location on computer, size and number of 

files and subfolders, date and time folder were created on, attributes (read only, hidden) 

To rename a folder, right click on the folder, and select Rename. Enter new name in place of 

highlighted text. 
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Widely Used Type of Files 

Right click on Desktop choose New to view widely used files.  

 

 

 

 

Creating Application File 
To create a new file, right click on the empty area of the desktop. Go to New and click on the file 

type you want to create. For example, to create a new word document, right click on the desktop, 

Go to New and select MS Word Document. 

To view the properties of software, right click on the file. File Properties window will open. 

 

To rename a file, right click on that file, and select Rename. Enter new name in place of highlighted 

text. 

To select a file, simply do a single click on it. 

 

File Attributes 

To view file attribute  

Right click on file 

Choose Properties 
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File Properties Panel consists of many tabs, for example  

 

1. General Tab – It will have File name, type, location on computer, size and date and time 

file created on, attributes (read only, hidden) 

Selecting Files 
To select multiple files 

1. Click on area near to one file and then drag around all files you need to select. 

2. Hold down Ctrl key and select all those files that need so be selected. 

3. To select adjacent or icons in a row, press Shift Key and select those icons. 

To make backup files/folders 

 

1. Copy the file/folder to another secondary storage device like floppy disk. 

2. Right click on the file folder and move your cursor to “Send To” option. Flash Drive Or 

copy file, open My Computer, Open Flash Drive and Paste in it.  

 

Formatting a USB Drive 
Attach USB drive with computer. Open My Computer and right click on the icon of the USB 

Drive. Right click on USB drive, select the “Format...” option. Choose quick format and click on 

start button. USB drive will be formatted, and all data will be removed. 

 

Searching File 

Open My Computer 

Write file name in search bar  

 

Summary 

In this lesson you have learnt 

 Directories / Folders 

 Widely Used Type of Files 

 Copying, Saving and Backup of Files 

 Selecting files  

 Process of formatting USB drive 
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Digital Literacy 

Module 02 

Print Management 

 

Objectives 
The objectives of these topics are to provide information about 

 

 How to install a printer? 

 

 Be able to take prints 

 

 Change the default printer 

 

 View job print status from the print manager 

 

Printer 
Printer is hardware. It outputs hardcopy (print on paper) of some file on your computer. 

 

Installation 
Installation or setup means to connect a printer with computer and copy necessary software on 

the computer. It can be divided into (1) Hardware Installation and (2)  

Software Installation  

 

Hardware Installation 

Connect the main power cable to power socket Put 

the USB cable into USB socket 

 

Switch the main power on. 
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LED on the printer panel will be on. Operating system detected the printer but unable to install 

because operating system does have required printer software driver.  

 

 

 

 

Software Installation 
Insert the CD containing printer-driver in CD Rom and then click on the next button 

Computer will copy and install all the required driver files and set it as default printer.  

 

Printing from installed printer 

You can use any of these to get the print of your document. 

 

1. Open your MS word file.  

2. Click on File < Print and press Ok. 

3. Press Ctrl + P to get the print of your document. 
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Printing in Network Environment  
1. Open your MS word file.  

2. Click on File < Print or Press Ctrl+P 

3. Choose Printer name from Printers list  

4. Click Print 

Print job status 

To view the print job status 

 

1. Click on the start < Devices and Printers 

2. Click on the printer icon representing printer, you sent prints to 

3. A new window for this printer will open which will display the information such 

as Document Name, status, Owner, Pages, Size, Submitted date/time and port etc.  

4. Or click Printer icon in system tray.  

Summary 

In this lesson you have learnt: 

 

 How to attach and install a printer with computer 

 How to take prints of any file 

 How to use printer 

 How to view job status 

 

 

 

 

 

 

 

 

 



 

 

 

56 

 

Digital Literacy                                                                           
 

Digital Literacy 

Module 03: Word Processing 

 

 

Objectives 

The objectives of these topics are to provide information about 

 Creating a New Document  

 Saving a Document  

 Opening a Document  

 Opening Multiple Documents 

 Typing Text 

 

Open MS word Application 
To open a MS word Application First Click on Button or press button 

From Keyboard.  

In the Start Menu Click on All Programs then find Microsoft Office there and click on it 

Chose Microsoft Office Word and Open it by single click.  

After clicking on the last option “Microsoft Office Word” in the sub menu you will a dialogue box 

with “Microsoft Office Word” written on it. This dialogue box is called splash screen. After few 

seconds splash screen will disappear, and MS word will be open. 

 

P.S. This sequence of opening a word document is according to Windows 7, Sequence of Opening 

Microsoft word can vary on different versions of Windows. 

 

Screen Layout 
Default screen layout is the layout of MS word when it is opened. We can change the default layout 

according to our will. 

 

In title bar, Name of the document with “Microsoft word” is written. If it’s a new document and 

not being saved yet, it will have temporary name like Document1, Document2 etc. 

 

A file created by word processing software is called document. 
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Menu bar or ribbon bar is a bar just below the title bar of the document. It contains Sub menus 

(File, Edit, View etc.) to give specific instructions to word processor. For example, File menu 

contains commands like Save, Close, Exit for the open document. Edit menu contains editing 

related commands like cut, copy, paste for the text of word document. 

Different Toolbars 

At the Upper right side of the title bar, you can see three buttons  

 

1- Minimize button –  This button is used to minimize (An open window will appear as 

icon in task bar) the word document. To maximize this window, click on its icon at the 

taskbar. 

 

2- Restore down button – This button is used to restore down the window to a smaller 

size on desktop. 

 

3- Close button – This button is used to close the document. 

Scroll Bars and Rulers 

 

Scroll Bar 
At the Right side and at the bottom of the Document There is Scroll bar. 

 With the Right vertical scroll bar  Document can be scrolled up and down. 
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 With the Bottom Horizontal Scroll bar  we can scroll document left 

or right. 

Rulers  
Rulers are at the left side and on the upper side of the document.

 

 Upper Ruler shows the starting and ending of a line in the document. 

 Left Rulers shows the starting and ending of the document. 

Rulers can also be adjusted as per our need. 

At the extreme bottom of the document status bar can be found. Status contains information about 

on which page we are right now how many words are present in the document.   

Opening a New Document 
To create a new document in Microsoft word from File menu we click on New and after that we 

select Blank Document. 

From Keyboard we can use shortcut key   +  to create new Document.  

Opening an existing Document 

A document which was previously created can also be opened from File menu, click on the File 

then Open and from the file dialog box select the document of your choice and click open. 

From Keyboard we can use shortcut key   +  to open a previously created document. 

Typing Some Text 

Text can be added on the Document white vacant area. Blinking Vertical line ‘|’can be found on 

the screen this is called cursor. Cursor shows the position of the text which will be entered next. 

Mostly this cursor is to right of the last word entered.  

Saving 

A Document can be saved in the computer hard disk for the later use, we can save document with 

some methods. 

 First method is to click on the save button from  Quick Access Toolbar. 

 Second Method is from File Menu we can click on save Button. 
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 Third Method is to Click  +  From Keyboard. 

After Clicking save from any of the above button a dialog will be opened, we can select the 

destination folder from there, and chose a name for our document and click the button save our 

document will be saved.  

Opening Editing and Saving Again  

We can open a file from File menu or by pressing short cut key   +   . 

 

Open file menu contains much option to organize, select and open a particular word document. 

From the file types we can select different file types to display in the file menu.   

Opening Multiple Documents Simultaneously  

In Real life we require more than one document at the same time. Microsoft Word Provides same 

functionality of opening and working with multiple documents simultaneously. 

To open Multiple Documents at the same time we simply navigate to target folder and double click 

on the document file(s). 

To switch between multiple documents, we simply use short key  + . 

Saving an Already saved Document  

A document which has already been created and saved to a location can also be saved to another 

location for example USB drive. 
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To save a document to another location we use save as feature of Microsoft Word, first we navigate 

to File Menu then from file menu we will select Save As Option a new window will be opened, 

from this opened window we can select the destination folder and click the save button to save the 

document to new destination. 

P.S. Remember after saving the file with save as feature will not remove the document from the 

previous folder, it will just make another copy of that document into new folder.   

 

Getting Help from Microsoft Office 

Help from Microsoft Word can be get in case someone cannot understand how to perform certain 

task. 

To get help from MS Word we use help button  at the upper right corner of the screen.  

Or shortcut key from keyboard   can be used. 

 

Closing a single document and closing Word  

To close a single document in MS Word from the File Menu select close option to close a single 

document. 

To close the Microsoft word application, click the cross button at upper right corner 

or press shortcut key from keyboard  + . 
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Digital Literacy 

Module 3 

Using Application 

 

Objectives 

The objectives of these topics are to provide information about: 

 How to adjust basic settings of MS word  

 Inserting different types of data in MS word 

 Inserting characters, Word sentence and Text 

 Undo Command  

 New Paragraph Insertion  

 Special Character and symbols  

 Page Break   

  

Change Page Display Mode  

We can change Display mode of MS word with the purpose of how page will be displayed to us. 

Display mode can be changed to following option: 

 Print Layout 

 Full Screen Reading  

 Web Layout  

 Outline  

 Draft  

To change the display mode, we need to click on View Ribbon Tab after clicking on View Tab on 

the very left we can find Document Views segment with different options of how the document 

will be displayed we can click on the required layout to set it for the current document.   
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Change Zoom level   

We sometimes need make document bigger or smaller with the intention of viewing a document 

more clearly or view more than one pages at the same time. 

To change zoom settings from view Ribbon Tab, click on Zoom, a new window will be opened 

with different zoom levels select the required zoom level and press OK. Zoom level can be changed 

with some other methods as well from the bottom right of the document we can see + and – Signs 

with a bar we can adjust zoom level from there. 

 

Edit Ribbon Tabs  

To edit ribbon tabs first right click on ribbon tabs and select customize The Ribbon Option From 

there.  

   

 

A new window will be opened with many options in it. Below are some features we can use to edit 

our ribbon bar:  

 In the right-side menu, we can check and uncheck a tab to show or hide it from ribbon tab. 

 We can move a ribbon tab up or down with  buttons to change its position in ribbon 

tabs. 

 

Changing file Format  

 Sometimes we need to save a file in specific format so that it can be opened in other software as 

well. 

To change file format from File Menu we click on Save As option a new window is opened, from 

this newly opened window we will click on save as option to change the file format and click save 

to save file. 
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Inserting Text  

To insert text into already written document or text we simply right click on the required position 

and simply insert the text we want to insert. 

 

Undo Command 

To undo the last action in MS Word we click on undo button   from quick access menu bar. We 

can do this with keyboard short cut key  + . 

 

Insert Special Character and Symbols  

Sometimes we need to insert mathematical symbols and characters which are not available on 

keyboard. 

To this from insert tab we click on symbol on the right side . 

A small drop down will be opened with some symbols in it we can select the symbol if we want 

or click on more symbols to select from more symbols and Special characters.   

Selecting, Cutting, Copy and Paste Operations 

Selecting Text  

Text can be selected using mouse left button or Using  key from Keyboard. To select 

text, we press and hold the mouse left button and move the mouse over the text to select selected 

text will highlighted, same with using shift key we press and hold shift key and press left or right 

arrow button or move mouse over the text to select. 

Copy, Cut and Paste Text  

We can copy or cut a text and later paste it in same document or another document. 
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 To copy selected text, we use copy button  from clipboard which is present at upper 

left corner of the application. Shortcut key from keyboard  + . 

 To cut the text we use cut button  from clip board or use shortcut key from   keyboard 

 + . 

 To Paste the text, we can use paste button  from clipboard or use Shortcut key from 

keyboard  + . 

Searching and Replacing 

Finding Text in Document   

 

To find a certain word or in a document we can use find feature of the MS Word, find button

 is on the upper right corner of the MS Word. Shortcut key from keyboard  + . 

 

 Feature can be used to find a phrase in the document.  

Finding and Replacing Text in Document   

 

We can also replace a word in the document in MS Word; sometimes we need to replace a specific 

word in the document which has already been written for example we have a document in which 

President of Pakistan’s Name is Musharaf and we need to change it Mamnoon Hussain so it is 

better to use find and Replace feature of MS Word.  

To use Find and Replace we will click on   from upper right corner just below the find. 

 

A new window will be opened with two text boxes, in the Find What field we will write the text 

we want to find and in the Replace field we will write the text we want to replace with the entered 

text and click Replace All Button to replace all or Simple Replace to Replace one by one. 
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Summary 

You learnt 

 Edit a document 

 Selecting text in document  

 Different command (Cut, Copy etc) 
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Digital Literacy 

Module 3 

Formatting 

 

Objective  

The objectives of these topics are to provide information about 

 How to change font size and color? 

 How to set alignment? 

 Creating hyperlink  

 How to add header and footer? 

 Correcting spell mistakes 

 

Changing Font Properties  

Font is the style how the text will be displayed  

in the document. To change font from Home Ribbon bar  

we will use font segment.   

This toolbar has many options in it below are some things we can do with it:  

 We can change the font Style  to another one for example Times New 

Roman or Broadway. 

 Font Size  can be increased to make text bigger or smaller. 

 We can make text highlighted  or change text color . 

 

Bold, Italic and Underlined  

 

We can make Text bold by clicking on B or make it Italicize by clicking on I or Make it 

Underlined.  

Shortcut Keys for making text bold, italic or Underlined are as follows. 
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Bold 

+  

Italic 

+  

Underlined 

+  

 

Indentation  

We can add spacing before new lines and in between lines in MS Word.  

To add new line space, we press  button from keyboard. 

To change line spacing we press  button from Paragraph Tab of Home Ribbon Bar. 

 

Changing Text Colors  

To change Text colors in MS Word we use Font Tab from Home Ribbon bar. To change text color, 

click on the . A dropdown will be opened with many colors in it we first select the text and 

then chose the color we want for the selected text. 

 

Alignment and Justification 

Sometimes we have a special need to align text right or in the center MS word makes it easy in the 

Paragraph Tab.  these are the alignment buttons we use to left, center and right align 

respectively. 

Shortcut keys for Alignments of text are:  

 

 

Left Align CTRL + L 

Center Align CTRL + E 
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Right Align CTRL + R 

 

We can also justify text in MS Word by click on justify Button  or use shortcut key CTRL + 

J. 

Hyperlink 

Sometimes we need to divert the reader of the document to a website, for this purpose we use 

hyperlinks. 

To insert a hyperlink first select the Insert Ribbon Tab and from insert tab select  a new 

window will be opened with Text to display and Address insert the link in the address and Text 

which should be displayed in the Text to display text box. The final link will look like this Virtual 

University . 

CTRL + K is the shortcut key to insert hyperlink from keyboard. 

Borders 

 MS Word Provides the Facility to insert borders to a paragraph or to full page. 

To insert borders, we use Page Layout from Ribbon bar and select    a new window will be 

opened with many options in it we can select the border width, color and style and then click OK 

to insert the border. 

Bullets 

To make points in the document we use bullets in MS Word.  

To insert Bullets in Home Tab from Paragraph sub Tab we can click on  to insert 

bullets. MS Word have different type of bullets which include numeric, alphabetic and styled 

bullets we can chose any of these as per requirement. 

 

 

Templates  

MS Word have many already well written and styled document samples which we can use as per 

our need these are called templates. 

http://www.vu.edu.pk/
http://www.vu.edu.pk/
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For example, you want to write CV and cannot chose how to style it you simply use a template. 

To use a template from the File Ribbon Tab we click on NEW and then click on .  

After clicking on this we will find many documents already well styled and we can choose the best 

style that suits us. 

Finishing a Document Styles and Pagination  

On a selected text we apply more than one style at a time, we can do this by simply clicking on 

more font button  from Font Tab. 

A new window will be opened, and we can choose many styles to apply on selected text. 

Changing Page Size/Setup  

Sometimes we need to change page size or style on which we are typing as per our printing or 

other requirements. 

To change page setup, we first click on Page Layout Ribbon Bar then in the Page Setup 

 

We can change Margins, Orientation and Size of the Page. 

Spelling and Grammar 

MS Word have built in Grammar we can use to correct spelling and other grammatical errors, 

whenever we write wrong spelling MS word automatically recognize it and underline it red to let 

us know that it wrong. We can right click on the underlined word and chose the correct spellings.  

 

Summary 

In these topics, you learnt 

 Change font size and color? 

 Set alignment? 

 Creating hyperlink  

 Add header and footer? 

 Correcting spell mistakes 
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Digital Literacy 

Module 03 

Tables 

 

Objectives  

 The objectives of these topics are to provide information about 

 How to create tables using MS word? 

 How to change column width and height?  

 How to insert and delete columns and rows from table?  

 How to format borders and change colors? 

 How to use images in documents? 

 

Tables – Introduction 

We usually use text in our documents. We can also use charts, graphs and pictures in our document 

file. Tabular data makes it easier for the reader to understand the information provided.  

 

Example of tabular data can be 

School Timetable  

Employee contact list  

Product sales report  

Drawing, charts and pictures can make a document look better and easy to understand.  

 

Rows and columns can be inserted into already built table, to insert a row or column select the 

place where you want to insert row or column then right click on it and from options menu select 

insert then select insert row or column to the left, right below or above the current row or column. 

Rows and columns can also be deleted from an existing table, to delete a row or column select the 

row or column and right click on it then select Delete cells option to delete the rows or column and 

data with it as well. 
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Changing Table Borders  

Borders of a Table can be styled according to requirements and needs. 

To change border of a Table first select the Table then select Design Tab from table Tools.

. 

After clicking on design Tab click on Borders. A drop-down menu will be opened with many 

features in it for different type of borders. We can select the border which we want to show/ hide. 

The last option in this drop down is Border and Shading. Upon clicking on Border and Shading 

a new window will be opened in this window we can select the border type, and color as per our 

requirements. 

 

Inserting Pictures  

A picture is worth thousand words. 

MS Word allows us to use pictures in the document to make it more self-explaining. For example, 

we are writing an article about embedded computers so, if we can show a picture of embedded 

computer in the article the reader will know without even reading the document that this article is 

about computers or more precisely embedded computers. 

To insert a picture into we have many ways some are discussed below: 

 First Method is to use Insert Tab from Ribbon bar. Click on Insert Tab click on  a 

new window will be opened to select picture from computer disk. 

 Second method is to drag and drop a picture straight from folder to MS Word. 

Pictures can resized and rotated as well, to do this we click on the inserted picture and then use the 

mouse to resize and rotate as per requirement. 

MS Word also provides the functionality of using already created graphics known as clip arts to 

insert the clip art same method is used as picture we click on    from insert tab a side bar will 

be opened from this bar we can search a clipart online. 
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Summary 

In these topics, you learnt: 

 Creation of tables in word processor 

 Changing table columns width and height 

 Insertion and deletion of columns and rows of table 

 Formatting of table borders 

 Use of pictures and images in document 
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Digital Literacy 

Module 03 

Preparing Outputs 

 

Objectives  

 The objective of this lecture is to provide information about  

 How to review and proof read a document  

 How to use word processor to proof read  

 How to remove spelling and grammar mistakes  

 How to take print out of a document  

 How to make use of different printing options 

 

Reviewing a document  

When a document is prepared, it is thoroughly checked with different perspective. A document is 

checked for its layout and information provided in it. Documents are also checked for its spelling 

and grammar mistakes. We should review our document made with the help of word processing 

application. 

A complete document review includes  

1. Complete page layout  

2. Page margins and numbering  

3. Header and footer settings  

4. Text and paragraph settings  

 

A very important part of document review is spelling and grammar check. A word processor gives 

us a very important feature of spelling and grammar check. It indicates any spelling mistake in the 

document and points out any grammatical mistake as well.  

 

While writing in MS word, spelling mistakes are shown by red lines and grammar mistakes are 

shown by green lines. Using the spelling and grammar check feature, we can remove mistakes 

from our document. 
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There are two methods to correct such mistakes in document. 

1. We can use the spelling and grammar check feature. 

    Go to the start of the document. Click Review tab 

    and Click on button highlighted in the figure. It will open a 

    new dialogue box with correct options. You can 

    do the correction, ignore it or add it to dictionary. 

 

2. We can use the right click of our mouse. Right click on the word with red line below it to see 

the available corrected options.   

 

 

 

 

 

 

Words not included in computer dictionary are highlighted as mistakes. For example, nouns like 

Places; Muslim names etc. are considered as spelling mistakes. We can add such words in 

dictionary so that they are not considered as mistake next time. Right click on the highlighted 

word, and select “Add to Dictionary” 

The green wavy line under the sentence represents a grammatical mistake. Computer is 

suggesting you to revise the fragment from the grammar perspective. 

Printing a document 

We can take prints of a document prepared in word processor. The files created using software 

and saved in computer called “soft copy”.  

To take the print you can do any of the following. 

Go to File < Print or 

Press Ctrl + P 
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A dialogue box will open in case, either option is followed. 

 

 

You will see different options available for print. You can select All, only current page, or page 

range for prints Multiple copies can be sent to printer at a time of a document with a single click. 

Select Printer 

If more than one printer is attached, we can select a printer we want to print from. 

Page Orientation 

We can select the available page orientation  

 Landscape  

 Portrait   

Page Sizes and Margins 

You can set page margins and select required page size for example A4, Letter and Legal. Margins 

can be also be chosen Narrow, Normal and other. 

Summary  

In these topics, you learnt: 

 Review and proof reading of a document 

 Using word processor to proof read 
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 Removing spelling and grammar mistakes 

 Taking print outs of a document 

 Different print out options  
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Digital Literacy 

Module 03 

Mail Merge 

Objectives 

 The objectives of these topics are to provide information about 

 What is mail merge and why we use it? 

 What are the important steps of mail merge? 

 How to create a mailing list? 

 How to create a mailing list with a document? 

 How to prepare mailing envelopes? 

 How to take print outs of a merged documents 

 

Basic concepts 

In merged mail we have some information that is merged with other letters to be posted after 

words. This mail can be our postal mail or electronic mail send by our pc. We use the mail merge 

feature provided by a word processor to merge out our information with letters and prepare them 

for delivery. 

Mail merge comprised of two steps. 

1. Prepare your letter or invitation. 

2. Prepare the list of people who will receive this letter. 

3. Merge the information from the list into main letter. 

For example, we need to send university students a convocation letter. Such invitation or letter is 

addressed to different person. Text of the invitation will be the same, but the name of the students 

and their addresses will be different. 

 

1. To develop invitations using mail merge feature do the following steps 

2. Click Mailings Tab.  

3. Click Start Mail Merge 

4. Click on  to start wizard. Mail merge pane will be opened at left 

side.  
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5. Select “Letters” radio button in the document type and click on the next: Starting document 

in the bottom of the panel. 

6. Select “Use the current document” and click on the “Next: Select recipients” 

7. Select “Type a new list” and click on Create… A new window will open with text fields. 

Enter information in text fields and click on OK. It will ask you to save the list. Enter 

“Students” and press enter. Click on “Next: write your letter” 

 

Insert Merge Field 

Click Mailing tab 

Click Insert Merge Field available in “Write and Insert Field” menu 

Select required field and Click Insert 

Click Close   

Edit Data List 

It is very easy to edit a list or add/delete 

a record in list. 

Click on the Mail recipient  button available in Start Mail Merge menu in Mailing tab. A 

new window will open with list you develop. Select any entry and click on Edit button in the 

window to do any changes. Once you enter into the edit mode for the particular list entry, you can 

delete, find, sort and add new entry. 

 

Mailing Envelopes  

Mailing Envelopes can also be created using mail Merge feature we can use already created list or 

create a new one. 

To create envelopes, we click on   from Mailings Tab. A new window will open select 

required options to adjust envelop according to need. 

Now that we are set up the Envelop we can click on    to select the list of people to print on 

these envelops. We can choose previously created list from the disk. 
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 After that we can click on   and insert the fields one by one just like we did for the letters. 

Now after inserting and finishing it we can print these envelopes. 

 

Printing a merged document 

Click on the “Finish and Merge” button in Mailing tab then Click Print Documents and 

Select “All” from the Merge to Printer window to take prints for all records. Soon after you 

click on the OK button, a new window will open for printer. Click on Ok button to send 

print request to printer. 

 

Summary 

In these topics, you learnt: 

 Feature of mail merge 

 Important Step of mail merge  

 Create mailing list 

 Merging of letter / Document  

 Creating mailing envelops 
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Digital Literacy 

Module 04: Microsoft Excel 

Introduction 

Objectives: 

The objectives of these topics are to provide information about 

 Interface of MS Excel 

 New Backstage view of Excel 

 How to modify or change the Ribbon and Quick Access toolbar? 

 How to make a new workbook? 

 How to open an existing workbook? 

 Select the cells 

 Insert the contents in cells 

 Delete the cells 

 Cut, Copy and Paste the cells 

 Fill the cells with fill handlers 

 How to edit the text, cell color and style 

 How to align the text within the cell 

 How to apply special formatting on Numbers and Dates 

 

Starting spread sheet software 

Microsoft Excel is popular and widely used spread sheet software. 

To open the excel file 

Click on start < All Programs < Microsoft Office < Microsoft Excel 

Or by only writing EXCEL in the search bar of task bar/start button. 

In the start a screen will appear for few seconds. This is called splash screen. A new excel file will 

open, after this screen would disappear. The by default arrangement of toolbars panels and sheets 

is called default layout. 
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Purpose: 

Main purpose of the spreadsheet software is to easily calculate numeric data in a very less period 

of time and to apply different formats on data. 

Development of Spreadsheet software: 

 In 1961, Prof. Richard Mattessich gave the idea of Electronic Spreadsheets. 

 In 1978, Dan Bricklin designed an interactive visible calculator program consisting of four 

columns and twenty rows which was named as VisiCalc. 

Purpose: 

Main purpose of VisiCalc software was to get user’s data and then to manipulate user’s data. 

Different Spreadsheet Software available in the market are: 

Gnumeric 

Kingsoft spreadsheets 

Spreadsheet (DHTMLX) 

LOTUS 1.2.3(Release 2.1)                      

Widely used software are: 

CA_ SuperCalc 

MultiPlan 

Quattro Pro®12 

Microsoft Excel 

What is spreadsheet? 

Spreadsheet is a collection of worksheets. Spreadsheet means to represent the accounting ledger’s 

book keeping record format. In other words, spreadsheet is a way of representing book keeping 

record of an accounting ledger.  

What is Workbook? 

Workbook is a collection of spreadsheets. 

MS Excel File is called a workbook. 
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What is Interface? 

Screen which appears for the first time when you open MS Excel is known as an interface. MS 

Excel 2007 and MS Excel 2010 Interfaces are similar to each other.  

 

 

There is a quick access toolbar on the top of the MS Excel interface. 

Below the Quick Access bar there is a Ribbon bar. 

Ribbon bar consists of different tabs like: 

File, Home, Insert, Page Layout, Formulas, Data, Review, View 

Below ribbon bar there is a Name Box and Formula bar. 
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Name Box: Represents a cell reference that is a cell location and number. It shows a cell 

complete address including the number of row and name of column.  

E.g. B2 (B is its column name and 2 is its row number.) 

Formula Bar: It is used to edit or change data by using the formula or text or function. 

Column: A group of different cells from Up-to-Down is called a column. 

Row: A group of different cells from Right-to-Left is called a row. 

There may be one or more worksheets in a workbook. 

Workbooks are also known as spreadsheets. 

By default, there are three spreadsheets in a workbook. 

About worksheets: 

You can scroll worksheets 

Also, you can Edit, Delete or add a worksheet. 

You can view a worksheet in three different ways: 

Normal view, Page Layout View and Page break preview (for overview) 

By default, workbook is opened in Normal view when excel is opened. 

How to modify the ribbon or quick access toolbar? 

1. Right click on the Ribbon; a pop-up menu will open 

2. Go to Customize the Ribbon option from the popup menu and click on Customize the 

Ribbon 

3. A new Excel Option dialogue box will open  

4. Click on the New tab button 

5. Add or remove your desired commands by checking and unchecking the check box and 

then click on OK button. 

Compatibility View in MS Excel: 

Compatibility view enables all old features and disables all new and advance features of MS Excel. 

MS excel 2010 file format is .XLSX  

Cell is the fundamental unit of MS Excel Worksheet. 

Cell is a rectangular box or an intersection point of a row and column. 

In cells Text, Formatting, Attributes, Formulas and Functions are inserted as a data. 
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How to Delete Cell Content? 

Click on the Home tab from the ribbon bar then go to Editing group of commands and then click 

on Clear; select clear content form the clear drop-down list. 

OR 

Select cell and press Backspace 

To delete contents from multiple cells: 

Select cells and press delete button. 

Note: There is a huge difference between cell Deletion and cell content deletion. 

To delete Cells from spreadsheet: 

Select the cells which you want to delete 

Click on Home tab from the Ribbon bar, then  

Click on Delete 

Select the row if you want to insert data below the row. 

Select the next column if you want to insert a column before the selected column. 

A formatted text enhances the readability of a reader. 

Text Wrap: 

Text wrapping is used to view complete cell content. It means cell content gets easily available by 

selecting to wrap text option. 

Wrap text option exists under the Home tab of the Ribbon Bar and in Alignment group. 

Merge and Center Cells: 

Select cells which you want to merge and center, then 

Go and Click on merge and center dropdown list under the home tab, then 



 

 

 

85 

 

Digital Literacy                                                                           
 

Select merge and center option from the dropdown list. 

 

How to change the text, cell color and style? 

Select the cells and then go to A^ button under the Home tab to grow font size 

Select the cells and then go to Av button under the Home tab to shrink font size 

By default, Numbers are bottom Right aligned in a cell 

While text is bottom left aligned in a cell. 

By default, each cell of the spreadsheet is set as a general format cell setting. 

Numbers are written in decimal format. 

Currency and decimal are specially aligned right and left respectively. 

 

Short Date: 

22/03/2017 

Long Date: 

Wednesday, April 22, 2017 

Time: 

hr : mm: ss 

Percentage: Data is written with percentage sign 400.00% 

Fraction: Data is written with forward slash. For example, 

¼ will be written same as ¼ in MS Excel. 

Note:  In general, ¼ will be written as 4-Jan. 

By default, Excel converts any large number value into scientific notation. 

By default, Excel is set in a text format. 

More Number formats option is used to convert dollars into PKR etc.  

Home<Number< More Number Formats Option. 

Summary 

In this lesson you have learnt 

 Modify or change the Ribbon and Quick Access toolbar 

 Make a new workbook 

 Open an existing workbook 
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 Select the cells 

 Insert the contents in cells 

 Delete the cells 

 Cut Copy and Paste the cells 

 Fill the cells with fill handlers 

 Change the text, cell color and style 

 Align the text and special formatting on Numbers and Dates 
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Digital Literacy 

Module 4 

Saving an Excel File 

Objectives: 

The objectives of these topics are to provide information about 

 How to Use Save and Save As Command? 

 How to Save the Compatible file of Excel 97-2003? 

 How to Save an Excel Work Book into PDF Format? 

 How to make Excel Simple formula? 

 How to use Add, Subtract, Multiply and Divide Functions? 

 How to calculate values with cell reference? 

 How to assign color and name to worksheet Tabs? 

 How to copy, move, delete and add the worksheet? 

 How to group and ungroup worksheets? 

 How to freeze rows and columns? 

 How to print workbook, worksheet and cells? 

 How to set page orientation, title margin and breaks? 

 

Save As: The Save as command is used, when you are saving your file (Excel file) for the first 

time or when you want to save yours excel file with another version of the excel file. For 

Example, if you want to save excel file created in MS Excel 2017 into MS Excel file 2003 then, 

Save as command is used. 

When you save any file with a save as command then your original file will also remain at its 

original location. 

By default, your file is saved in My Document folder. 

Save: Save command is used to save your workbook on current location. 

To recover your saved file, go to   

File<Info<Version then, 

Click on restore button from the popup menu. 

By default, Excel auto saves an Excel file after every ten minutes. 
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A file will not auto save if you will close excel file before 10min. 

Compatibility Mode: Compatibility mode disables all new and advance features and enables 

only those basic features which are used to make only a workbook. 

Note: Old version of excel can only be opened in an advance excel in its compatibility mode only. 

Save as a PDF 

To save your workbook in Adobe Acrobat format is called to save as a PDF file. 

Purpose to save as a PDF: 

 Helps reader to read who do not have MS Excel 

 Just Read your Workbook as a PDF file 

 Reader cannot edit your workbook 

How save a file as a PDF? 

File < Save As select PDF from the drop-down list of file type. 

By default, Excel only converts that worksheet in PDF on which you are working currently. 

To convert whole workbook or all worksheets in PDF: 

Go to File < Save as then, 

Click on Option button and select entire book option and then ok 

Creating Simple Formulas 

What is Formula? 

Mathematical equation which is used to perform different mathematical calculations is called a 

formula i.e. Similar to calculator that is used to perform different calculations. 

Standard Mathematical Operations: 

+ Plus: For Addition 

-Minus: For Subtraction 

* Asterisk: For Multiplication 

/ Forward Slash: For Division 

^ Caret: For Exponent 

In MS Excel all formulas are applied with an equivalent sign. 

Note: Excel will never tell you that either your formula is right or wrong. 
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To create a simple formula in Excel: 

Select cell in which you want to show your result then, enter value in formula bar 

Creating Formula with cell reference: 

Select cell in which you want to show your result then, first write cell name and secondly its value 

in formula bar and in last press enter. For Example, If you want to select Column C and Row 3 

then, write C3 in formula bar. 

To create a formula with point and click method: 

Select the cell in which you want to show result then, enter formula in it. For Example, 

=C3*C4 

How to Edit a Formula? 

Double click on the cell  

OR 

First select cell and then edit (or change) it in formula bar.  

Introduction to worksheets 
By default, a worksheet tab named as sheet1is displayed on the bottom left side of the screen when 

you open MS Excel for the first time. 

You can copy, delete, move, insert, rename and can also give colors to the spreadsheets. 

Rename Worksheets 

Right click on current (selected) worksheet then, go to rename and rename it. 

To Delete Multiple sheets from the spreadsheet: 

Press Shift tab and select different sheets which you want to delete then, right click on any selected 

sheet and finally click on delete. 

Move or copy worksheet: 
Right click on the sheet which you want to copy or move. 

Go to move and copy option and then check create and copy checkbox and finally click on OK 

button. 

Result: a new same worksheet with an updated version will be created. 
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Move a spreadsheet: 

Drag the worksheet and then drop the spreadsheet when a dropdown arrow v gets appeared on the 

worksheet tab. 

To color a worksheet: To color a worksheet means to give color to the worksheet tab. 

Right click on worksheet tab then, go to tab color option and select color of your own choice, and 

finally click on OK button. 

 

Grouping and Ungrouping worksheets: 

Press Ctrl key from the keyboard and click on all those worksheet tabs which you want to group. 

 

Ungrouping the worksheets:  

Right click on worksheet tab then, click on ungroup option. 

 

Freezing worksheet panes 
You can freeze one or more sheets in Excel this is called Freezing Panes. 

Freezing is very helpful when you scroll your worksheet. 

 

How to freeze a row? 

Select the next row to the row which you want to freeze. 

Go to View tab i.e. situated on the Ribbon Bar.  

After clicking on the view tab, select freeze pane option from the freezing command dropdown 

list. 

 

Press Ctrl+F2 to view page print preview 

 

How to print a worksheet on a paper: 
Click on File tab from the Ribbon bar, a back-stage view will open 

Click on Print option from the Back-stage view, Different printing options e.g., Print, Printer and 

Setting will appear on the left side of the opening window and Print Preview will be displayed on 

the right side. 

A document or worksheet can be printed in two different layout styles 
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1. Landscape Style 

2. Portrait Style 

Landscape Style: In Landscape style a worksheet is horizontally set 

Portrait Style: In Portrait Style a worksheet is vertically set 

 

It is better to print in Landscape when large numbers of columns are needed to print on the paper 

How to reduce worksheet size? 
Click on File tab, then 

Click on Print option  

On the left side under settings click on No Scaling dropdown list then, 

Click on Fit sheet on one page, finally click on OK button. 

Margin: Printed worksheet border content or distance from the text is known as the margin. 

To use print titles: 

 Click on Page Layout tab from the Ribbon bar select print title command from the page 

setup group of commands 

 Page setup dialogue box will open 

 Enter row value in the Rows to repeat at top textbox.  

How to break a worksheet: 

Select the column from where you want to break the spreadsheet, then 

Click on Page layout tab from the Ribbon bar.  

Go to Page setup group of commands and click on break dropdown list and then click on insert 

page break option to insert the break.  
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Summary 
In this lesson you have learnt 

 Save and Save As Command 

 Save the Compatible file of Excel 97-2003 

 Save an Excel Work Book into PDF Format 

 Make Excel Simple formula 

 Add, Subtract, Multiply and Divide Functions 

 Calculate values with cell reference 

 Assign color and name to worksheet Tabs 

 Copy, move, delete and add the worksheet 

 Group and ungroup worksheets 

 Freeze rows and columns 

 Print workbook, worksheet and cells 

 Set page orientation, title margin and breaks 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

93 

 

Digital Literacy                                                                           
 

Digital Literacy 

Module 4 

Creating Complex Formulas 

Objectives 

The objectives of these topics are to provide information about 

 How to write Complex Formulas in Excel? 

 What are Relative and Absolute Cell References? 

 What a Fill Formula and Copy Formula according to cell Reference? 

  

Complex Formulas contains more than one mathematical formulas or functions 

In complex formulas order of operations is very important. 

Order of Operations: 

 

Perform the operation in parenthesis ‘()’ first 

Caret ^ in second 

Multiplication / Division in third  

Addition / Subtraction in fourth 

Working with cell reference and absolute reference: 

Generally, a cell reference is called a relative cell reference or simply a cell reference. 

A cell reference with $ sign in the start is called an absolute reference. 

By pressing the F4 key a function can be changed to its absolute reference. 

 

Functions: 
Function is a predefined formula for calculation. 

For Example,  

Sum formula in Excel is =Sum (B3:B12) 

Each function has a specific order which is known as syntax. 

Some common functions are: 

Sum, Average, Product, Count 
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Arguments in a function tell you how or in which way the function will 

execute. 

Reference of each cell is written in parenthesis with colon or comma. 

:  Sign represents cell range reference 

=Count (C1:C5, C7:C10, C11:C15) 

“,” Comma Sign represents Individual value. It means comma sign in a function represents an 

individual cell reference and value. 

Note: Excel will not tell you either your function is true or false. 

 

Using Common Functions to represent Auto Sum: 
 Select the cell in which you want to show your result, then 

 Go to Formula tab on the Ribbon bar, then 

 Click on Auto sum dropdown list from the function library group of commands and click 

sum from the options. Now select all those cells who’s Sum you want to calculate and then, 

press enter key from the keyboard. 

Auto sum dropdown list in Function Library Command group contains different options such as 

Sum, Average, Count Numbers, Max, Min etc. 

Function Library under the Formula Tab contains different group of formula commands. For 

Example, Math and Trig formulas are used to calculate Mathematical and Trigonometric functions. 

More functions category includes: Statistical, Engineering, Cube and Compatibility 

functions. 

MS excel also contains very useful Date & Time functions. For Example, with the help of date and 

time function current date of the system can be easily determined. 

Similarly, NETWORKDAYS function is a very helpful function in MS Excel. 

How to use NETWORKDAYS Function? 

Select the cell in which you want to show your result. 

 Go to Formula tab that is situated on the Ribbon Bar in MS Excel 

 Click on Formula tab and select date and time dropdown list from the function library. 

Equal Sign 

= Sum 

(B3:B12) 

Function Name 

Arguments 
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 Select NETWORKDAYS option from the date and time dropdown list 

 

Summary 

In this lesson you have learnt  

 Write Complex Formulas in Excel 

 Relative and Absolute Cell References 

 Fill Formula and Copy Formula according to cell Reference 
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Digital Literacy 

Module 4 

Sorting Data 

Objectives: 

The objectives of these topics are to provide information about 

 How to apply sorting in a worksheet? 

 What is sorting? 

 Way of arranging data in a specific order is called sorting. 

 

Different types of sorting 

 Alphabetically sorting 

 Numerical sorting 

 Sort by date and time 

 Customized sorting 

 Sort by cell color, fort color or cell icon 

Click on Data bar then, click on sort from the dropdown list 

Data < Sort  

Sort dialogue box will open. 

Select column, sort on and order of your choice form the dropdown list.  

You can also filter data of your own choice. 

Tables Formatting: 

You can also change the table color. 

Click on home tab and select Format and table option 

A dropdown list with different colors will open. Select the color of your own type from the list. 

Template: 

By default, template is a collection of different color combinations, effects, fonts and settings. 

You can use MS excel built in templates by clicking on file tab then,  

Click on new tab and selecting sample template from it. 
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Chart: 
In MS Excel, a chart is a tool to represent our data graphically. 

Purpose: 

Charts are used to display our audience the hidden meanings of numbers and figures and their 

comparison. 

Column Chart 

Pie Chart 

Line Chart 

Bar Chart 

Area Chart  

Surface Chart 

Different parts of a chart: 

Title of the chart 

Vertical Axis 

Data Series 

Legend 

 

How to create a chart in a worksheet? 
Insert < chart 

To change the chart type 

Right click on the chart 

Select change chart type from the menu 

Reviewing and sharing worksheets 

Review < select track changes from changes group 

Click on the Review tab from the menu bar, then 

Click on the Track Changes dropdown menu from the Changes group of commands 
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Click on the Highlight changes option from the dropdown menu 

A highlight changes dialogue box will open, now 

Check the checkbox, that is, Track changes while editing. This also shares your workbook, then 

Apply track of your choice and click on OK button. 

 

Adding and Deleting Comments: 

Comments are used to get some information about data. 

Comments are used for our convenience. 

How to insert a comment? 

 Select the cell 

 Go to Review tab on the Ribbon bar 

 Click on review tab then, 

 Click on comment option 

Or  

Select cell and then press Shift+F2 from the keyboard. 

Use of Document Inspector: 

Click on File tab  

A back-stage view will open 

Click on Check for Issues drop down list then, select inspect document option from the list 

By default, anybody can copy, delete or edit your worksheet data. 

Using Conditional Formatting: 

First of all, select your spreadsheet data 

Go to Home tab and click on conditional formatting drop down list from the group of style 

commands under the home tab. 

 

Pivot table: 

A kind of interactive table which automatically abstracts organizes and summarizes the data. Pivot 

table summarizes the data, making it easier to manage. Best of all, you can quickly and easily 

change the pivot table to see the data in a different way making it an extremely powerful tool. 

Go to insert tab on the Ribbon bar 
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Click on the Pivot table dropdown list under the inset tab. 

Select pivot table option from the dropdown list. 

Summary 

In this lesson you have learnt 

 Sorting in a worksheet  

 Apply track changes 

 Add comments 

 Working with Charts 
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Digital Literacy 

Module 05: Microsoft PowerPoint 

Introduction 

 

Objectives: 

The objectives of these topics are to provide information about 

 Environment of Microsoft PowerPoint 2010 

 What is backstage view? 

 What is Ribbon and Quick Access Toolbar? 

 How to make a new presentation? 

 Back stage view is new in MS PowerPoint 2010. 

 How to add new slides? 

 How to change presentation layout? 

 How to arrange presentation slides? 

 How to change slide view? 

 How to add notes in a slide? 

 

In past it was very hard to write and present at the same time. Power point is useful software to 

prepare any type of presentation. Power Point is such type of presentation software with the help 

of which we can create a dynamic slide presentation. Dynamic slide animation includes 

Animations, text, sound, pictures and videos. 

 

Elements of a Slide: 

 Text 

 Videos 

 Bullet List 

 Pictures and Charts 

You can add more than one slide in a presentation. You can play/view slide show any time by 

clicking on the Slide show option from the Ribbon bar.  

OR  
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Simply press F5 from the keyboard. 

 

Menu Bar: Menu bar contains different tabs. For Example, 

Home, Insert, Design, Transitions, Animations, Slide Show, Review, View, Acrobat 

 

There are different group of commands under each tab. 

For Example, 

Tables and Picture options are found under the Insert tab. 

 

To Customize the Ribbon: 

Right click on the Ribbon 

Click on the customize the ribbon from the menu list 

A new Power Point option dialogue box will open 

Click on the new tab from the dialogue box, then  

Add or remove different tabs of your own choice. 

Click OK 

 

Minimize or Show the Ribbon: 

Click on the ^ button from the Ribbon bar to Hide the Ribbon bar 

OR 

Right click on the Ribbon bar, then 

Click on the Minimize the Ribbon option from the menu list. 

 

The Quick Access Tool Bar: 

Tool bar on the top of the Ribbon bar is the Quick Access Tool bar 

Quick access tool bar contains different Shortcut buttons  

E.g. Save button, undo button etc. 

 

To add commands to the Quick Access Tool bar: 

Right click on the Quick Access tool bar, then 
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Click on Customize Quick access toolbar  

A new Power point option dialogue box will open 

Add or Remove buttons of your own choice 

And then, click on OK button. 

 

Backstage View: 

Back stage view is a new feature in MS Power Point 2010. 

View which appears when you click on the file button on the Ribbon bar is called the Back-stage 

view. 

 

Blank Presentation: 

Click on the File button from the Ribbon bar 

Backstage view will open 

Click on New a new menu list will open 

Since Blank Presentation is already selected. 

Click on Create button to create a new blank document. 

 

To open an existing Presentation: 

Click on File button, then 

Click on Open 

A new dialogue box will open  

Browse and select the file and click on Open Button. 

 

Compatibility mode: 

Compatibility mode is used to convert the presentation. 
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Slide Basics: 

Objectives: 

 How to add new slides? 

 How to change presentation layout? 

 How to arrange presentation slides? 

 How to change slide view? 

 How to add notes in a slide? 

 

In power point there are place holders to insert the text. 

 

Place Holder: 

That input area which shows us on the slide in form of dotted area. 

We can insert tables, charts and texts in the place holder. 

 

About slide Layouts: 

You can arrange your slide content in different ways. 

 

Customizing Slide Layout: 

Select the slide, then 

Click on Home tab from the menu bar 

Click on layout dropdown list from the slides group of commands. 

Now you can select any layout of your own choice from the list of layout dropdown menu. 

 

Removing Place holder from the slide: 

Select the place holder boundary, then 

Press Backspace or Delete from the keyboard. 

 

How to insert text on in the place holder? 

Click on the home tab, then 

Click on Drawing Box from the group of Drawing Commands. 
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To use a Blank Slide: 

Click on the Home tab, then  

Click on the layout dropdown list and select blank slide from the dropdown menu. 

 

Working with slides: 

Click on the home button from the Ribbon bar 

Click on new slide dropdown button 

Slide layout view will open 

Select any one layout from the dropdown menu. 

 

Instantly generating a slide: 

Click on New Slide button in the slides group of commands under the home tab. 

OR 

Press Ctrl + M 

 

By doing so a slide with the same layout will be created on which you are already working. 

 

To Copy and Paste a slide: 

Select the slide to which you want to copy, then  

Click on click on the new slide dropdown button under the Home Tab and then, 

Click on Duplicate Selected slide option from the dropdown list. 

 

To Delete a Slide: 

Select the slide and then, Press Backspace or Delete button from the keyboard. 

 

Managing Slides and Presentations: 

About Slide Views: 

o Normal View 

o Slide Sorter View 

o Reading View 
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Click on the View tab from the Ribbon Bar, then 

Click on slide sorter view from the presentation views group of commands 

 

In slide sorter view you can arrange different files or see different presentation files. 

Slide sorter view is also used to make it sure that all slides in the presentation exists and to check 

that there is no any extra slide in the presentation. 

 

Indentation and Line Spacing: 

You can change the Presentation with the help of Indentation and line spacing. 

 

What is Multilevel List? 

Different Indenting Levels in the slide shows multiple lists. 

 

To Indent Using the Tab key: 

Place the pointer in the start of the text and then, Press Tab key from the keyboard. 

To use the indent commands: 

Click on the Home tab from the Ribbon bar, then 

Click on increase indent text button in the group of paragraph commands. 

Similarly, click on decrease indent text button in the group of paragraph command to decrease 

indentation. 

 

When you further indent a list with already indented text then, it is called multilevel list. 

 

Fine Tuning Indent: 

By default, a ruler is hidden so you have to show it first. 

 

How to show a ruler? 

Click on the view tab from the Ribbon bar, then 

Check the ruler checkbox from the show group of commands. 
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To customize bullet spacing: 

With the help of first line indent maker or hanging indent you can adjust space between bullets 

and text. 

 

Line Spacing: 

To format line spacing, Click on Home tab from the ribbon bar and then, 

Click on Line spacing dropdown menu from the group of paragraph commands. 

Select the line spacing from the line spacing dropdown menu. 

 

Presentation Notes for the Presenter: 

How to number the Slides? 

Click on Insert tab from the Ribbon Bar, then 

Click on slide number button from the Paragraph group of commands. 

A new Header and Footer Dialogue box will open 

By default, Slide tab is selected 

Check the slide number check box under the Slide tab, then 

Click on OK button. 

 

Bullets and Numbering: 

By default, alignment is set to center. 

Justify option is used when there is a huge text the page. 

 

How to convert text into smart graphics? 

Click on Convert to smart dropdown list button from the Paragraph group of commands under the 

home tab, then  

Select the smart graphic of your own choice from the Convert to smart dropdown list. 

 

Applying a theme: 

By Default, a theme is the collection with color combinations, different fonts, affects and settings. 

Theme can be changed any time when you need. 

How to change the theme? 



 

 

 

107 

 

Digital Literacy                                                                           
 

Click on the Home tab from the Ribbon bar, then 

Click on new from the back-stage view 

A new menu list will open 

Select on Themes button under the Home heading. 

Now you can apply any theme from the given themes. 

Click on OK button to apply the theme. 

 

Elements of the Theme: 

 Color of the theme 

 Theme Fonts 

 Shape Styles 

 

How to apply themes? 

Click on the Design tab from the menu bar, then  

Select any theme from the themes group of commands. 

 

How to insert image in a slide? 

You can insert image in a slide with the help of Picture, Clipart and Screenshot commands. 

 

How to insert an image from the file? 

 Click on the Insert tab from the Ribbon bar, then 

 Click on the picture from the image group of commands 

 A new Insert Picture Dialogue box will open. Select the picture and click on the insert 

button. 

 

Slide Master: 

With the help of slide master, we can set the contents of all other slides. 

Click on the View tab from the Ribbon bar, then  

Click on the slide master view command from the master Views group of commands. 
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Summary 

In this lesson you have learnt  

 Environment of Microsoft PowerPoint 2010 

 Backstage view 

 Ribbon and Quick Access Toolbar 

 Make a new presentation 

 Back stage view is new in MS PowerPoint 2010. 

 Add new slides 

 Change presentation layout 

 Re-arrange presentation slides 

 Change slide view 

 Add notes in a slide 
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Digital Literacy 

Module 5 

Move, Copy or Delete the text 

 

Objective 

The objectives of these topics are to provide information about 

 How to change slide orientation? 

 How to add notes for presenter? 

 How to use spell-check program? 

 How to print a slide in different views? 

 How to insert different objects? 

 How to fill colors in objects? 

 How to scale and move the objects? 

 How to create charts in slides?  

 

Use copy and paste commands to duplicate the text: 

Select the text, then 

Click on Copy command under the home tab  

OR  

Press Ctrl+C from the keyboard. 

and 

Press Ctrl+V to paste the text. 

 

Use Cut and Paste commands to move text within the presentation: 

Select the text, then 

Click on Cut command under the home tab  

OR  

Press Ctrl+X from the keyboard. 

and 
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Press Ctrl+V to paste the text. 

Delete the Selected text: 

Double click on the text to select the text. 

Press Delete Button from the keyboard. 

 

Copy, Move or Duplicate the images: 

Select the image, then 

Click on Copy command under Home tab and then 

Click on Paste command under the Home tab. 

 

Text Formatting: 

Select the text and then, 

Click on the Home tab from the Ribbon bar, then 

Click on Font size dropdown menu to increase or decrease the text file. 

Similarly, you can apply different text formatting on the selected text with the help of Font group 

of commands. 

Text formatting includes Text color, Font size, Font Style, Text shadow, Bold, Italic, Underline, 

text shade etc. 

 

Increasing or Decreasing Font Size: 

 

How to Increase Font Size? 

Select the text and then, 

Click on A^   button to increase the font size 

A^    will increase 2 scale on each click. But after 20scale unit it will increase with 4-scales 

 

How to Decrease Font Size? 

Select the text and then, 

Click on A^   button to decrease the font size 

A^    will decrease 2 scale on each click. But after 20scale unit it will decrease with 4-scales 



 

 

 

111 

 

Digital Literacy                                                                           
 

 

 

Clear the Formatting: 

Select the text and then, 

Click on Home tab from the menu bar, then 

Click on Aa/ button from the font group of commands. 

 

Character Spacing: 

 AV is used to insert character spacing on the selected text. 

Different character spacing options are:  

Very tight, tight, Normal, loose, very loose and more spacing. 

 

Case: 

Aav is used to change the case of the selected text. 

Different options with Aav are: 

Sentence Case, Lowercase, uppercase, Capitalize each word, Toggle case. 

 

Using spell check for presentation text: 

Select the text, then 

Click on the Review tab from the Ribbon bar, then 

Click on the Spelling command under the Review tab 

OR 

Simply, press F7 from the keyboard after selecting the text. 

 

Graphics and Charts: 

Draw the objects: 

To add various forms of shapes: 

Click on the Home tab from the Ribbon bar, then 

Select any shape from the drawings group of commands. 
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Change the attributes of the shape: 

To change the color and line type of the shape: 

Select the shape, then 

Go to the drawing group of commands under the Home tab. 

 

To Create an Organizational chart: 

What is chart? 

A tool with the help of which we can represent our data graphically 

Different kinds of a chart are: 

Column chart, Pie chart, line chart, bar chart, area chart and surface chart. 

Different Parts of a chart: 

Title of the chart 

Vertical axis 

Data Series 

Legend (usually, it is about x-axis data and scale) 

 

How to insert a chart? 

Click on the Insert tab from the menu bar, then 

Click on chart button from the illustrations group of commands. 

 

Right click on the chart to change the chart type. 

 

Import other objects, texts, spreadsheet, table chart or graphics to the slides: 

Go to object command under the Insert tab from the menu bar 

Insert Object dialogue box will open 

Select Create from file radio button and then, 

Click on Browse… button to Browse the object and then, click on OK button 

 

Add border objects to an object or picture: 

Right click on the object, then 
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Click on format object option 

A new format object dialogue box will open 

 

Printing and Distribution: 

First thing is to select a suitable presentation slide view for a presentation. 

Click on the Design tab from the ribbon bar, then 

Click on the page setup button from the page setup group of commands 

Page setup dialogue box will open 

Use different Page setup features and click on OK button. 

 

Change Slide Orientation Landscape or Portrait: 

By default, direction of a slide is Landscape. 

 

How to change a slide in portrait? 

 Click on the design tab from the ribbon bar, then 

 Click on the Slide Orientation dropdown menu and then, 

 Select portrait from the menu list. 

 

Preview the presentation in slide outline as a slider sorter: 

Click on View tab form the menu bar, then 

Click on slider sorter command from the group of Presentation View commands. 

 

Print slides in various views and outputs: 

Click on File tab from the Ribbon bar 

Backstage will open after under the file tab, then 

Click on Print command from the backstage view. 

Print menu list will open. 

Print menu list contains different options like Print, Printer settings etc. 

Note: Collated option under settings in Print Menu list is used to print your slides in the form of 

groups. 
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Slide Show Effects: 

Objectives: 

 How to set animation effects in slides? 

 How to change animation effects? 

 How to add transition between slides? 

 

Preset animations: 

Select the text, then 

Click on animation tab from the ribbon 

Under Animation tab option; there are animation, advance animation and timing group of 

commands. 

 

Note: 

You can view animation preview with the help of Preview button under the animation tab. 

 

Summary  

In this lesson you have learnt  

 Move, copy and paste commands 

 Insert different objects 

 Fill colors in objects 

 Scale and move the objects 

 Create charts in slides 

 Animation effects in slides 

 Change animation effects 

 Add transition between slides 

 Change slide orientation 

 Add notes for presenter 

 Use spell-check program 

 Print a slide in different views 
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Digital Literacy 

Module 5 

Change Preset Animation Effect 

 

Objective 

The objectives of these topics are to provide information about 

 How to create a slide show? 

 How to use on-screen navigation tools? 

 How to hide slides? 

 How to insert smart Art Graphics in a presentation? 

 How to modify colors and effects? 

 How to change the organization of graphics in the presentation? 

 How to insert hyperlinks? 

 How to insert Action Buttons?  

 How to insert table? 

 How to apply Table style? 

 How to format the Table using different commands? 

 Rehearsal and Practice of Presentation 

 Record the slide shows in advance  

 Other Options in PowerPoint 

 

We will now discuss how to change Animation effect which has been set already. To do this click 

on   from Advance Animation Tab from Animations Ribbon Tab. A new side 

Bar will be opened on the right side. On this side bar we can play animation using play button. 

From this Animation pane we can change the settings of effect or totally remove it. 

1. Transitions 

Transition is the effect when we move from one slide to another slide. To apply Transition on a 

slide we use Transition Tab from Ribbon Bar. 
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Transition can be applied to a slide which will be displayed when that slide is opened from previous 

slide or directly. 

Every Transition has some special properties associated with it for example an effect will be from 

left to right or from right to left. These settings can be accessed from . 

To apply a Transition to a slide from Transition tab we can select a Transition effect which will be 

applied to that Slide. We can also use Apply to All option to apply the current Transition to all the 

slides. 

 

To View a slide show and Deliver Presentation 

Objectives  

In this Lesson we will learn 

 How to create a slide show? 

 How to use on-screen navigation tools? 

 How to hide slides? 

1. Deliver Presentation  

Now that we have completed our presentation with all the effects and Transitions it’s time to start 

slide show and Deliver Presentation.  

To start slide show, click on Slide Show from Ribbon Bar. This tab has many options to start slide 

show, slide show can be started from the beginning or from a current slide. 

To start from beginning we click on From Beginning or Press F5 keyboard to move to next slide 

we can press space bar or arrow keys.    

 2. On Screen Navigation Tool   

When slide show is started we can see on bottom left of the slide  Navigation 

Buttons. 

It has four buttons: 

 Arrow buttons on left and right for the navigation to move previous and next slide 

respectively. 
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 The pen button is used for the option to show/hide pen from slide, we can use the pen to 

quickly draw or highlight a point or some important word. 

 The last button is navigation button which provides us option to move to specific slide. 

Hide the Slides   

We can hide a slide in MS power point if we do not want it to show in the slide show for any 

reason. 

To do this, select the slide you want to hide and click on slide Show from Ribbon Bar and then 

from that tab click on  button from that tab. Slide will be hidden from slide show but it will 

be shown in the side bar with all slides with a cross on it. 

 

Smart Art Illustrations 

Objectives  

In this lesson you will learn  

 How to insert smart Art Graphics in a presentation? 

 How to modify colors and effects? 

 How to change the organization of graphics in the presentation?  

 

Insert Smart Art Graphics 

To insert smart art, go to Insert Tab from Ribbon bar and then click on .A new window will 

be opened with many Smart Graphics in it which is categorized, select the required smart art and 

press OK button that Graphics will be inserted to current slide. 

 

Add Text Smart Art Graphic 

After inserting Graphics, we can observe that on the left side of that graphics  Arrows button 

are generated click on these arrows button and we can see that a left pane is opened with text boxes 

in it, we can add the required text into these boxes which will be applied to the slide’s Graphics.  
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Convert Existing Text to Smart Art Graphic 

To convert existing text to smart art right click on the text already written then from the dropdown 

select convert to smart art chose your required smart art and click OK from the new window. 

Smart art can also be converted back to text, to do this select the smart art and then click on design 

tab and select convert option and from two options select convert to text.  

 

Change the organization of Smart Art Graphic 

To change the organization of smart art Graphics, select a smart art and click on design tab after 

that click on , a new dropdown will be opened we can click on the one of the options 

for example if you want to add shape above the selected shape we will click on add shape above. 

 

To Move shapes to higher or lower level 

We can change the position of shape to higher or lower level to do this click on design tab and 

then select promote or demote option from left side to move shape higher or lower. 

Shortcut keys can also be used to demote shape press  key. And press Backspace to 

promote shape.  

Rearrange shapes on the same level 

To rearrange shapes on the same level, click on design tab and from there click on move up or 

down to change level of shapes. 

 

Modifying the smart Art Graphics appearance   

To change the appearance of smart art graphics, select the graphics and then click on design tab 

and from there find the layout tab and expand it now you can select the required design by clicking 

on it or simply mouse hover to just preview it. 
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Change the smart Art style  

To change the style of smart art graphics, select the graphics and then click on design tab and from 

there find the smart art styles and expand it you can select the required style by clicking on it or 

simply mouse hover to just preview it. 

 

Change the smart Art color scheme  

Select the graphics and then click on the design tab and click on  a new dropdown will be 

opened select the required color and it will applied to that shape. Style and colors of a single shape 

inside the smart art graphics can also be modified to change it select the single shape and change 

the color and format of that shape. 

 

Document Exchange 

1. Save and Existing document to another file format  

If we want to save an already created document to another file format we can chose save as option. 

First open the presentation then click on the file tab from Ribbon Bar, after that select the Save as 

option a new window will be opened select the required file type from    and click on 

Save button. 

 

Hyperlinks and action buttons   

Objectives 

In this Lesson you will learn 

 How to insert hyperlinks? 

 How to insert Action Buttons?  

 

Insert Hyperlinks 

Inserting a hyperlink is pretty straight forward, first select the text, picture or shape you want to 

convert to hyperlink then right click on it and select hyperlink from the dropdown menu a new 

window will be opened with Text to display and Address, insert the link in the address and Text 
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which should be displayed in the Text to display text box. The final link will look like this Virtual 

University . 

Hyperlink can also be inserted from insert tab using  button. 

Using hyperlink for email is the same method just we have to select email option from the 

hyperlink window. 

 

Insert Hyperlinks to another slide  

First select the text, picture or shape you want to convert to hyperlink then right click on it and 

select hyperlink and in the hyperlink window select Place in this Document option and select the 

slide you want to link and click OK. 

 

Insert Hyperlinks to another file  

In the hyperlink window select the file in the files menu and click OK. Now whenever you will 

click on that hyperlink the new file will be opened. 

 

Remove Hyperlinks 

Right click on the hyperlink and click delete hyperlink from the dropdown menu, hyperlink will 

be removed while the text or image will remain there. 

 

Inserting Action Buttons  

Action buttons are very useful in PowerPoint whenever we click on action button an action will 

be performed this action can be move to next slide or play a sound. 

To insert action button, click on the insert tab from the ribbon bar and then click on shapes a 

dropdown will be opened find the action buttons on the end of this dropdown and select the 

required action button and draw it on the slide. 

After action button is inserted a window will be opened with many actions like hyperlink or play 

sound or open a program, chose your required action and click OK. 

Action buttons can also be applied to master slide so that the buttons will show on each slide. 

 

http://www.vu.edu.pk/
http://www.vu.edu.pk/
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Change the appearance of Action Buttons  

To change the style or color of action button first select the action button then click on design tab, 

select the required color shape and appearance of the button.  

 

Working with Tables 

Objectives 

In this lesson you will learn  

 How to insert table? 

 How to apply Table style? 

 How to format the Table using different commands? 

 

Insert a blank Table  

To insert a table simply Go to Insert Tab from Ribbon Bar and select  option and in the 

dropdown menu you can simply insert a quick table selecting the small boxes. 

To insert a more advanced table select insert Table option, after selecting a new window will be 

opened you can select the number of rows and columns to insert table.   

 

Move and resize Table 

Moving the table is very easy and simple, move the mouse to the sides of table and when the mouse 

pointer changes to four headed arrows click and drag the table to another place. 

To resize it move the mouse pointer to extreme edges of the table when mouse pointer changes 

click and drag to resize it. 

 

Add Columns and rows 

Rows and columns can be inserted into already built table, to insert a row or column select the 

place where you want to insert row or column then right click on it and from options menu select 

insert then select insert row or column to the left, right below or above the current row or column. 
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Rows and columns can also be deleted from an existing table, to delete a row or column select the 

row or column and right click on it then select Delete cells option to delete the rows or column and 

data with it as well. 

 

Change Table Styles  

Select the Table and then click on design tab then find the table styles with different table style, 

hover the mouse on the style to preview a style and click the mouse button to select that style. 

Table styles option can also be changed from right side of design tab also we can add or remove 

borders from table as per requirement from borders and shading section. 

Advanced Options in PowerPoint  

Objectives 

In this lesson you will learn  

 Rehearsal and Practice of Presentation 

 Record the slide shows in advance  

 Other Options in PowerPoint 

Open slide show tab and click on Rephrase option to start slide show and record it.  

Slideshow can also be recorded by using record slide show option from slide show tab. 

 

Present slideshow as video      

Click on file menu and find create video option to create video. Chose the required resolution and 

quality of video and save presentation as video. 

 

Broadcast slideshow     

We can also broadcast the slideshow to do this from slide show tab click on Broadcast slide show 

option to start broadcast chose the right settings and start broadcast. 

 

Summary 

In this lesson you have learnt  

 Create a slide show 
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 Use on-screen navigation tools 

 Hide slides 

 Insert smart Art Graphics in a presentation 

 Modify colors and effects 

 Insert hyperlinks 

 Insert table 

 Apply Table style 

 Format the Table using different commands 

 Rehearsal and Practice of Presentation 

 Record the slide shows in advance  

 Other Options in PowerPoint 
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Digital Literacy 

Module 06: Internet and Communication 

Introduction 

 

Objectives 

The objective of this topic is to provide information about: 

 ISP 

 Web Browser  

 Feature of Internet Explorer  

 Opening of Multiple Web Pages 

 Browser’s Settings and Use of Help file 

 

WWW: stands for World Wide Web, It was introduced in 1991 and is the application of internet. 

World Wide Web means collection of online documents, which are stored in computers as services 

connected to internet and is the way to collect information from internet  
All of the websites in the world, taken together, make up the World Wide Web. We can get 

information from the World Wide Web through browsers. 
 
Internet: The Internet is the worldwide network of interconnected computers, including both web 

servers and computers like the one on your desk that run web browser software and share 

information, Instant messaging , email etc.  
 
Web page, web site and web server 
 
Website: website is the way to get information on internet and it provide lot of information related 

to any topic. A website is a collection of web pages maintained by a single person or organization. 

A website has a distinct domain name, such as www.vu.edu.pk.  
 
Web Page: every website is made up of one or more web pages. Web page contains text, 
sound, images and videos etc. 
 
Web Server: web servers are the computers that actually run websites and are connected to 

internet. Each website has its own web server and it stores all web pages on server. Web server 

control web site and it has special software to store collection of websites. The most common web 

server software is Apache, followed by Microsoft Internet Information Server. 
 
Web Browser: Browse means to see through some object or thing. When we visit some website 
it means we are browsing that site. To see some website on internet we need some browser. 
Browsers are those programs that let you explore information on www or programs to view a 
website is called web browser. Many of web browser are available in the market like internet 
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explorer, Google Chrome, Mozilla Firefox, Opera and Safari etc. purpose of all these browsers are 
only to browse Web pages but all the web browser provides different features along it like 
bookmark , history etc.  We will only discuss feature of Internet Explorer 11.  
 

 

 

ISP, How to connect internet 

 

ISP stands for internet service provider. ISP are always connected to internet, is basically a 

company or organization which facilitate user by taking some fee. User can connect to internet 

through ISP’s. Most of ISP’s let you connect to internet through by dialing a local phone number. 
 
To connect through internet we need computer, modem and telephone line. 

 

There are different ways to connect your computer or mobile with internet. For example 
 
 
 
ISDN: stands for integrated service digital network. It is a digital phone line. Data transfer speed 

is faster than modem.  

 

Now a day we can connect to internet by  

 

 TV Cable 

 DSL 

 3G 

 4G 

 Wi-Fi 

 

First step with the web browser 

 

To open internet explorer:  

Click on Start < All Programs < Internet Explorer or Click  from desktop 

Or click Internet Explorer in Taskbar 
 

 

Basic layout and closing a web browser 

 

All browser contain menu bar, title bar, address bar, tool bar, New tab button, status bar, scroll bar 

etc. Basic component of Internet Explorer are title bar, menu bar, status bar, tool bar, scroll bar 

etc. 
 
Title Bar: The most upper bar of window is called title bar. On the right side of title bar there are 

three buttons to minimize, restore and close internet explorer.  
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Minimize button is used to minimize the window. Restore is use to restore down and close button 

is use to close the internet explorer 

New Tab:  New tab makes easier to manage having multiple pages open within browser 

simultaneously. 

 

 

 
 

 

 

Menu bar: There is another bar after the address bar is called menu bar. Menu bar contains 

different options to use features like file, edit, view etc. 
 
 
 

 

For using any main menu we just move the mouse cursor over it and it will show submenu. 
 
Toolbar: The strip next to menu bar is toolbar. Toolbar is shortcut of menu bar sub 

options. We also called it standard toolbar because it has buttons to perform important 

tasks. 

We can use these options by clicking icons. For knowing the purpose of these icons just take the 

mouse pointer over there and wait for a while you will see name of icon in form of label. This label 

is called tool tip text. 

 

Address bar: displays URL of open web page. 

 

 
 
 
 
Progress Bar: A standard Windows control that displays the percentage of completion of 

a particular process as a graphical bar 
 
 

 

Browser pan: The area in middle of screen shows some text, hyperlinks and graphics are called 

content area or browser pan. 
 
To close Browser there are several methods like 1- 

Click File < Close  
2- Press Cross button (X) on title bar 
 

Protocol 

New Tab Title 
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Data is transferred from one computer to other through some rules, these rules are called 

protocol. Different protocols are used on internet like HTTP, HTTPS, FTP and TCP/IP 

etc. 
 
HTTP: stands for hypertext transfer protocol. It is protocol to transfer Webpages from web server 

to web browser. Basic purpose of http is to transfer those pages which contain hypertext links. All 

web pages URL start with http. For example: http:// vu.edu.pk 

 

HTTPS: stands for hypertext transfer protocol secure. It provides safe communication between 

two computers.  
 
FTP: stands for file transfer protocol. Using this protocol we can access files from the ftp server. 

Ftp server are those computers on internet which store different type of files. These servers are 

maintained by universities, college or agencies etc. Some files on the ftp can only be accessed by 

some specific users, to copy these types of files we have to enter their password. For anonymous 

ftp sites, files are accesses without any password.  
 
Understand makeup & structure of URL 

 

IP Address: 203.215.176.42 which is hard to remember. Using host masking this IP address 

converts into character base URL which is easy to memorize.  

For example, we can store mobile number using person name. Like 0123124567 store using Ali 

name.  

 

User do not need to remember IP addresses of different websites. But it is easy to remember their 

URLs addresses.  

 

 
 

URL stands for Uniform Resource Locator. A URL can be thought of as the "unique address" of 

a web page and is sometimes referred to informally as a "web address." URLs are used to write 

links linking one page to another; for an example, http:// vu.edu.pk. 
 
Structure of URL: 
 
A URL is made up of several parts. 
 
For example http:// vu.edu.pk/cgi-bin/neomail.pl 
 
The first part is the protocol, which tells the web browser what sort of server it will be talking to 

in order to fetch the URL. In this example, the protocol is http. 
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The Second part is its name, which tells about the organization, it is associated like vu.edu.pk. 
 
The third part of the example URL is the path at which this particular web page is located on 

the web server. http:// vu.edu.pk/cgi-bin/neomail.pl 
 
8. Search Engines 

 

Search means to find something. Search engines are program that searches documents for specified 

keywords and returns a list of the documents where the keywords were found. Like Google, 

AltaVista etc. 
 
Search engines used software called spider to search documents on internet. Documents are sent 

to search indexing software. Indexing software extract information from documents storing in 

database, then database is search for that documents that match to our word search. Search engines 

assembles web page that shows the result as hypertext link. 
 
 
How to change home page in web browser 
 
When we start internet explorer, the first page we see on the screen is called home page or start 

page.  
To change home page: 

Click Tools < Internet Options < General < Address 
 
Display web page in new window 

 

We want to open web page without closing other or copy a web page then: 

Click File < New < Window 
 
Stop a web page from downloading 
 
In many situations, we stop web page from opening for example when a web page take a lot 

of time to open, click on wrong link , some portion of web page open and we just stop for 

further processing.  

 

We can stop a web page either of two ways: 

      1- Click View < Stop  

2- Click on Stop button  
 
Refresh a web page 
 
Refresh means to view web page with latest changes. Using this option we do not have to enter 

URL in address bar again. 
 
We can refresh a page by three ways: 
 
1- Press F5 key  
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2- Refresh button   
3- Click View < Refresh 
 
16. Display previously visited sites 
 
When we visit some sites in browser, the browser keep its address of sites which we opened 

before. Browser saves these sites in history. 

 

To view history: 

Press Ctrl+H or Click  available at right side of browser toolbar.  

 

Changing number of days in history list 

 

We can set number of days that our history 

should be kept. To change history days: 

Click Tools < Internet Options 

 

This dialogue box will open.  
Select history section to change days. 
 
 

 

 

Deleting single entry, clear list of history 
 
It is possible to delete history item or history 

list. 
 
To delete single item: 
 
1- Right Click on Item  
2- Select delete 
 
To delete list: 
 
1- Click Tools < Internet Options  
2- Select History section to delete history 

 

Help 

Click Help in menu bar and choose Internet Explorer Help  

Or Press F1 

 

Modify Toolbar: Right click on toolbar, choose desire option from the open list.  

 

 

http://www.bing.com/images/search?view=detailV2&ccid=A40uG1bi&id=C50A7C7388DC10A6B00543AB1E87D77E1B0E8362&q=refresh+button+internet+explorer&simid=608003732266356554&selectedIndex=3
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Change webpage view settings: Click view, choose Zoom, Choose desired zoom view value. 

Or Press Ctrl + for Zoom in and Press Ctrl – for zoom out.  

 

Change webpage text size: Click view, Choose Text size, Choose desired text view option 
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Digital Literacy 

Module 06 

Web Navigation 

 

Objectives 

 The objective of this topic is to provide information about: 

 How to go to any URL? 

 How to activate a hyperlink/image link? 

 How to move backward and forward in visited websites? 

 How to place a bookmark on web page and how to view it? 

 How to create a book mark folder and add web page in it? 

 How to delete a book mark? 

 

Opening a website 

 
To visit any website, we should know its URL, URL is typed in address bar of browser. 

 

Navigating backward and forward in a web page 
 

 To move backward: Click Backward button  

 

 To move forward:  Click forward button  

 To move home page: Click Home button 

 Click view Choose Go to and select any visited website 
 

 We can move backward and forward using key board e.g. ALT+LEFT and ALT+RIGHT 
 
Hypertext Links 

 

Hypertext is text that links to other information. When we click with mouse on hypertext link it 

is activated means it moves you to next page you click. Some links bring to download a file, 

broadcast TV or radio. 

 

Hypermedia Links 

 Picture 

 Graphics 

 Audio 

 Video  
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Hyperlink Shape: Click on any hyperlink will change mouse pointer into hand   shape.  

 
Methods to open link 
Some links are opened in same window or some are in other window. 

 

To open link in new tab: 

Right clink on link 

Select open in new tab 

  
To open link in other window: 

Right click on link 

Select open in new window 
 

 

Book mark a web page 
 
When we visit some site and we like it, we can save it. For saving any site it mean we are making 

bookmark means we are putting mark on this site that we can open it again. We can make list of 

those sites which we like, some browser say it Book mark and some browser say it favorite. 
 
To put site in favorite, we can have several methods:  

1- Click Favorite button from toolbar 

2- Click on Favorite < Add to favorites 
 
Creating a book mark folder and add page in it  
When list of favorites grow long, we can make it short by 
making folder and also we can organize them. 

To organize:  
1-Click on Favorite < Organize Favorite 
 
 
A dialogue box will open, Click on New Folder.  
This will create a folder. 
 
To add page in this folder:  

1-Click Favorite < Add to Favorite A dialogue box will 

open.  
2- Select Folder from Create in option. 

3- Add page in it. 
 
Delete a book mark 
 
We can delete web pages or folders from favorites list. 
 
To delete folder:  
Click on favorite < organize favorites 
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Select Folder / page 

Select delete button to delete folder. 
 
Display book marked page on toolbar 
 
To display favorites in tool bar as shortcut: Click 

View < Toolbar < Favorites Bar 
 
Viewing favorite list on screen 
 
We can also see favorites item on the left side of screen. To 

view on left side of screen:  
Click on Favorites Star Button from right side of toolbar. 

Click  button from the explorer bar.  

 

Copy a text from a web page to a document 

 

Duplicate means to copy same data on different location. We can copy or duplicate any text 

or image data. 
 
To copy Data:  

1- Select data 

2- Click Edit < Copy or press Ctrl+C 
 
To paste Data:  

1- Select target location 

2- Click Edit < Paste or press Ctrl+V 
 
Copy image from web page to a document 
 
To copy image:  

3- Select image 

4- Click Edit < Copy or press Ctrl+C 
 
To paste image:  

3- Select target location 

4- Click Edit < Paste or press Ctrl+V 
 
Copy URL from web page to a document 
 
We can also copy URL from browser to a document. 
 
To copy URL:  

5- Select URL from browser 

6- Click Edit < Copy or press Ctrl+C 
 
To paste URL:  
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5- Select target location  
6- Click Edit < Paste or press Ctrl+V 

 
Save a web page on hard disk  
We can save a web page on the hard disk. We can open web page data without connecting to 
the internet. To save a web page on hard disk:  
1-Click File < Save As 

2- Select target location on disk to  

 

Save a graphic 
 
We can save a graphic as file. 
 
To save graphic:  
1- Right Click on graphic 

2- Select Save Picture As option 

3- Select target location and Enter Name of graphic 
 
Download text file, image 
 
Downloading is process of transferring file from remote computer to user computer. 
 
To download a file:  

 

1- Select File  
2- Right Click on file 

3- Select Save Target As 

You can also save an image in the same way as file. 

 

Printing web page 
 
To print a web page: Click File < Print 

Summary: 
 
In this lesson we have learnt:  

 Web navigation  

 Process of navigation 

 Organizing bookmarks and favorites  

 Saving of web contents  
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Digital Literacy 

Module 06 

Search Engines 

 

Objectives 

The objective of this lecture is to provide information about: 

 How search engine work? 

 How to refine narrow searching? 

 Use of Boolean operators 

 

Search Engines 

World wide web contain millions of web pages that it’s difficult to tell their exact figure, so to find 

out required information is possible through search engines. Search engines help us to find 

information on the web and store the information about web pages. It usually searches web pages 

according to any phrase or keyword.  

 

Search engine visit websites using different software, for example 

 Spider  

 Web crawler 

 

Spider: it is called spider because spider visits many websites in parallel at the same time and also 

visit different web servers. When the Spider search Web server it makes central repository to save 

related websites URLS’s. This repository of web server is called database or index. After specific 

intervals, spider store new and updated websites URLS’s in database. 

 

How to use any search engine 

There are many search engines on net like Google, Yahoo and Bing etc. 
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To search any website: 

Write keyword in entry box 

Search Specific site: 

Write keyword in double quotations. 

When we search any web site, relevant websites are on front page. 

 

Combine selection criteria in search 

With simple search, we can get variety of results. We can refine and narrow these results. 

To use selection criteria: Use Boolean operator like AND, OR and NOT 

 

Use AND operator:  

Open Yahoo search engine  

Write Hardware AND Software in search text area 

Its mean show webpages which contain both hardware and software words 

Use OR operator: 

Write Hardware OR Software in search text area  

Its mean show webpages which contain hardware or software word  

 

Use NOT operator:  

Write Hardware NOT Software in search text area  

Its mean show webpages which contain only hardware word 

Note: write Boolean operators in capital 

 

Advance Search 

Click on Advanced Search options in search engine 

Or  

Click settings, choose Advance search  

Search results can be found in the form of images, videos and Books etc.  

 

Summary: 

In this lesson we have learnt: 
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 What are search engines and how to select a search engine? 

 How to use Boolean operators? 

 How to use advance search? 
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Digital Literacy 

Module 06 

Email Application 

 

Objectives 

The objectives of these topics are to provide information about: 

 

 Email application 

 Email account configuration  

 Receiving and reading email  

 

Application use to send or receive email is called email application for example, Microsoft 

outlook, IncrediMail and Windows Live 

 

Using Microsoft Outlook 

Click Start button  

Click All Programs  

Click Microsoft Office  

Click Microsoft Outlook  
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Click Next button  

Select No  

Click Next  

Check Use outlook without an email account  

Click Finish  
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Microsoft Outlook Layout    

 

 

 

 

 

 

 

Email Account Setting 

Click File 

Click Account Setting  

 

Ribbon 

Navigation 

Pane 

Content 

Area 

Reading 

Pane 
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Click New 
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Click Manual setup or addition server types 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

143 

 

Digital Literacy                                                                           
 

 

 

 

Choose POP or IMAP 

 

Click Next  
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Fill form with your email server information 

Fill data as described in video  

Click More Settings 
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Fill form as shown in figure 

Press Ok 

Click Test Account settings  

 

 

 

 

Click Next 

Click Finish 

 

Email Application Inbox: 

Click Inbox in Navigation Page 

Click Send and Receive button in Home ribbon  

 

Reading a message: 

Click on Inbox  

Click on email message in Content area 
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Mark message as read/unread 

 

Messages which we have read called read messages and messages which we have not read are 

called unread. It is possible to make read messages as unread and unread messages as read. 

 

To make a message as read: 

1- Select message 

2- Right click on message 

3- Select Mark as read 

If we marked a folder then all its messages are marked as read /unread 

 

Writing Email: 

Click new button in Home tab 

 

 

Write email address in To 

Write Subject  

Write message in text area  

 

Click Send 

Responding an email message: 

Click email message  

Click Reply or Reply All in Home tab 

Write your reply in next window  
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Click Send 

Click sent Items in navigation pane to check sent emails 

 

Copy and Paste Email Text 

Select text from reading pane  

Right click and click copy  

Click New email  

Right click in message area and click paste  

 

 

Cut and Paste Email Text 

Select text from reading pane  

Right click and click cut  

Click New email  

Right click in message area and click paste  

 

Email Signature setting  

Click New Email 

Click Signature button in Message tab 

Click New and write CPL 

Write details in Edit Signature  

Click OK  

 

Insert signature in email message 

Click New Email 

Click email message area  

Click Signature  

Click CPL  

 

Proof reading means to remove spelling mistake from your email messages.   

Click Review tab 
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Click Spell & Grammar 

 

Download File attached in email: 

A file can be send and receive through email.  

Click received email 

Right Click attached file  

Click Save as  

 

Attach File with email: 

A text, image, audio or video file can be send through email attachment feature.  

Click New Email 

Click Attach File in Message tab 

Locate your file and Click Insert 

 

Search Email Message:  

Write relevant keywords in search box available in content area to find any relevant email.  

 

Close Email Application 

Click cross button  

 

Summary 

We have learnt in this lesson: 

 What is email? 

 Using email application  

 Configuring email account  

 Send and Receiving email  

 

 

 

 



 

 

 

149 

 

Digital Literacy                                                                           
 

Digital Literacy 

Module 06 

Electronic Mail 

 

Objectives 

The objectives of these topics are to provide information about: 

 What is an email? 

 How to create email account? 

 Using email account  

 

Concepts 

In ancient times, people use letter as way of communication and they send it through post offices 

but it took long time to reach destination. In modern days way of communication have been 

changed because of internet and new ways were adopted to send information quickly e.g. telegram, 

fax, telephone and email etc. 

 

Email is abbreviation of electronic mail. With the help of email, we can exchange information 

around the world. Only difference between email and other letter is that email is written through 

key board and sends through internet while letter is written by hand and send through post office. 

It is the fastest way of communication than letters and it can be sending at any time when it is 

convenient.  

 

Famous Email Client 

Gmail 

Hotmail 

Yahoo email 

Communicator 

 

 

SMTP: is simple mail transfer protocol and used to send and receive email messages. 
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POP3: is post office protocol and used to receive email messages. Email client interacts with POP3 

server to discover and download new email messages. 

 

How email works 

First you compose a mail and send it. Message is sent to your internet service provider’s email 

server. Message is then sorted in recipient’s electronic mail box. To read message, log on to email 

server and retrieve message. To read message, first you have to enter password. 

 

Email system using email client SMTP and POP3 

Steps to send email messages: 

 

1- Message is prepared using email client. 

2- Email client sent it to SMTP server (if receiver is local then mail goes to POP3) 

3- Receiver computer picks it at his/her computer 

4- If mail is sent to SMTP than SMTP server send it to local computers POP3 and receive it 

 

Understanding the structure of email address 

Whenever we send any mail we should know the address of recipient.  

 

Structure of Email address: Email address consists of two parts separated by “@ “symbol. First 

part identifies the name of user account and second part contains URL of persons account on 

internet like awais@yahoo.com 

 

 

Layout of email application 

Any email program contains components to write, send and receive email messages. 

 

Create an email account 

To use an email program it’s important to have email 

account. 
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To create an account on yahoo: 

1- Type www.mail.yahoo.com in browser  

2- Click on Create account 

3- Fill the Form by entering user name and password and more 

 

Open a mail box for specific user 

You can open email account which you have created before by user name and password. Enter 

User name and password and Click Sign In. 

 

Open one and several messages 

Whenever we got any email, it goes to our inbox. We can read and write mail here. 

To read mail: 

 

 Click on Inbox 

 Click on ay message to read 

 

To compose a mail: 

Click on Compose 

Write and send mail 

 

Close a mail message 

To close a mail message: 

Click on Close (X) button of window 
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Summary: 

In this lesson we have learnt: 

 Type of email server (SMPT and POP) 

 What is email and what is structure of email address  

 How to create email address? 

 Read messages in mailbox.  
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Digital Literacy 

Module 06 

Mail Management 

 

 

Objectives 

The objective of this lecture is to provide information about: 

 How to create a new address list and add or delete mail address in it? 

 How to create a new folder and how to move messages to a new folder? 

 How to sort and delete the messages? 

 How to undelete the deleted messages and how to empty delete item folder? 

 

Managing email 

When we receive many mail messages, it results into overabundance of email messages in inbox 

or sent email folder. As a good practice, these should be managed. To manage your email, you 

can follow options. 

 

1. Create new folders for messages 

2. Save your messages in hard disk 

3. Delete unwanted or read messages 

 

Create an address book 

In real life, you can use diary to record the name and address of your friend. It is good to use 

diary to remember the details of your friends. It is difficult to remember many email addresses. 

Email program makes life easy by providing a facility to record email ids of all contacts in 

address book. You can save name, phone number, email IDs and some related information in an 

address book. Address book works like a diary. 
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Add a mail address to address list 

 

1. Click on the New Item in home tab  

2. Click Contact 

3. A new window will open. Enter name and email id of the contact and click on Save and 

Close button below the menu bar. 

 

Contact Group: is like a sub address book which contain email addresses of specific group 

people. For example, Friend Group, Sales Group and Purchase Group etc.  

 

Creating Contact Group 

Click contact from Navigation pane  

Click New contact group  

Write Group name  

Click Add Members  

Choose required option 

 

Delete a mail address to address list 

The way we have added the contact in address book, we can delete the contact with few clicks. 

 

1. Select the email contact (s) from address book by single click. 

 

2. Click on the Remove member button or right click on the contact name and select delete 

from the drop-down menu. 

 

3. Contact(s) will be deleted. 

 

4. To delete complete address book, click delete group button 
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Create a folder 

 

It is good to organize messages in 

different folders. Email program usually save 

messages in separate folders. You can create as 

many folders you want. 

 

To create a new folder 

 

Go to Folder Tab 

Click New Folder Enter the name of new folder 

 

Write name of folder and specify location. 

 

Move messages to folder 

To save a message in a new folder 

 

Select the message in the inbox 

 

Right click on message 

Choose Move  

Click other folder where you want to move the message 

and click on the Ok button. 

 

Sort messages 

We can sort email messages by date, subject and sender name. Let us sort these messages by 

date wise.  

Steps: 

 

Open inbox  

Click Arrange by in content area  
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Choose any option to sort by your choice 

 

 

Message Tagging 

Step: 

Click New Message 

Click High / Low Importance in Message tab 

 

Flag mail message 

After reading the mail you have two options. Some mails are replied urgently, and some are replied 

late. It is possible we forgot to reply some urgent messages, so for this reason flag feature is 

introduced. 

 

To apply flag on the message of inbox folder:  

1. select a message 

2. Click on Follow Up in Home tab 

  

Flag To remove flag: 

 

1. Right click on message 

2. Select Clear Flag Option 

 

Delete a message 

You can easily remove any message. Right click on the message you want to delete from inbox 

and select Delete from the menu. Email message will be deleted from inbox right away and sent 

to folder “Deleted items”. 

 

Undelete a message from Deleted Items 

You may delete important message. When you delete a message, it is moved from inbox to 

deleted items folder. Open “Deleted items” folder and right click on the message you want to 

undelete. Select “Move to folder” option and select Inbox. 
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Summary 

In this lesson we have learnt: 

 Creation of a new address book 

 Addition and deletion of addresses in address book 

 Message sorting 

 Set Message Priority 
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Digital Literacy 

Module 06 

Introduction to Social Media 

 

Introduction 

Social networking sites are great for keeping in touch with family and friends, and letting the world 

know what you’re up to. The Online Engagement Guidelines make it clear that we encourage the 

safe and responsible use of social networking sites. This document contains guidance on how to 

help you stay safe and to think about what you post online. Remember that there may be those 

who are using such sites for unsavory reasons. These can range from criminals looking for ways 

to con you or steal your identity, to those who may wish us harm. While it is unlikely that you’ll 

fall victim, you should be aware of the risk. 

 

Social Media Websites 

Whenever you join a new social network, you should always look at the privacy and security 

settings, so you are aware of how much information the service is sharing about you, and who is 

going to be able to see it. If you’ve been a member of a social network for some time, it’s worth 

looking at the privacy and security settings frequently as they are subject to change. Each social 

network deals with privacy and security in different ways, and you shouldn’t share information on 

their service until you know where that information will end up. 

 

Two Step Security 

Two-step, or two-factor authentication protects your accounts by requiring you to provide an 

additional piece of information after you give your password to get into your account. In the most 

common implementation, after correctly entering your password, an online service will send you 

a text message with a unique string of numbers that you’ll need to punch in to get access to your 

account.  
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The idea is that you’re drastically more secure if somebody needs both your password and the 

physical phone to get access to your accounts. Add a passcode to your phone, and you’re 

safeguarded against someone stealing both.  

 

Facebook 

Facebook is a social networking website which allows users to make friends, write text to update 

his/her status, upload pictures and video and share with friends and family. User can change 

privacy settings to restrict the view of his/her postings.  

 

Twitter 

Twitter is an online news and social networking website that make it easy to communicate with 

people in short messages called tweet. User can change privacy settings to restrict the view of 

his/her postings.  

 

YouTube 

YouTube is a video uploading and sharing website where user can like and comments on videos. 

The video can be accessed on PCs, laptop and mobile phone. User can change privacy settings to 

restrict the view of his/her videos.  

 

Pictures and Videos 

Pictures are powerful and often revealing assets, and while photos can contain trivial information 

they can also pose a risk to personal and operational security if placed in the wrong hands. Whether 

in a professional or personal capacity, you should always consider what information you are 

revealing through imagery you publish online or anywhere in a public domain. 

 

Always consider how the images and videos you publish might be interpreted, and what level of 

information they are really displaying. Remember, unless you have appropriate privacy settings 

activated, there is a strong chance that your images can be viewed by the wider public, so consider 

whether you wish to identify yourself, family members or your location, and how you are 

representing your profession.   
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Location Services and Geotagging 

Various social media services can use information about your location, either from a mobile 

device, or from your computer, and attach it to information you share on their site. Although there 

is nothing wrong, under the right circumstances, in sharing your location in this way, you need to 

keep in mind how much information you are giving, and whether you are comfortable with it. 

 

Friends and Family 

It’s not just you who needs to think about your personal security online. Your friends and family 

will often know about your deployment, travel arrangements, and other information that should 

not be publicly available. To make sure they don’t share this information, you will need to speak 

to them about what they can and cannot talk about. You should also ask them to read through this 

document so that they too can make informed decisions about what they share on social media. 

 

 

Commenting and Debating 

Many news websites, blogs and social networking sites allow you to give your views about 

subjects in comments sections beneath particular stories, and forums provide a place in which 

many people share their opinions. However, on these sites there are some things you need to bear 

in mind: Be careful about giving away too much information as some blogs, news websites and 

forums are easier to search than sites such as Facebook and keep their information easily accessible 

for longer than sites such as Twitter. 

 

Never share anything which could breach operational security in a comment section or forum, and 

be careful not to share personal information such as where you live, names of your family 

members, or information about anyone else unless you’ve received their permission in advance 
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Fraud, Scams and Blackmail 

Phishing, scams, frauds and hoaxes are a major source of cybercrime affecting many internet users. 

Most users have a basic awareness of computer viruses and a general notion of what constitutes 

identity theft, but a number of people don’t realize the real threat that phishing, frauds and scams 

pose.  

 

Given the increasing popularity of social networking sites and the general improvement in email 

filters, scammers are now using these sites more and more in an attempt to harvest private 

information and commit varying levels of identity fraud. On such sites, most users believe they 

are in a secure network, but this is not the case. The relative ease of creating accounts or setting 

up profiles provides an easy foundation for scammers to begin a number of fraudulent activities. 

 

General Tips 

Scammers are always trying to evolve their techniques and use different methods to con people, 

so take care on all social networking sites and when using mobile applications. Remember: 

 

 Use strong and unique passwords, with a different one for each site. 

 Always check you’re in the actual main site before entering any login information. 

 Be wary of suspicious links, requests for passwords and unusual 

comments/messages/updates from friends/followers. Scrutinize all requests carefully. 

 Limit what information you share on your profile/account such as birth dates, phone 

numbers and use of geo-locating services. Use privacy settings to your advantage 

 Keep your computer software and browser up-to-date and virus-free. 

 Select third-party applications with care. 

 If it’s too good to be true, it usually isn’t. So, don’t fall for it! 

 

Information Security Guide Reference 

(https://assets.publishing.service.gov.uk/government/uploads/system/uploads/attachment_data/fil

e/251555/onlineSecurity20131018b.pdf) 


